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KAPITEL 1

Kurseinfuhrung

1.1

Vorwort

Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS,
we will tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the
functions you expect from a GIS program, and more!

1.1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly
used GIS functions. Why should anyone be using QGIS over some other GIS software package?

Here are only some of the reasons:

It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero money. No initial
fee, no recurring fee, nothing.

It’s free, as in liberty. If you need extra functionality in QGIS, you can do more than just hope it will be included
in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with
programming.

It’s constantly developing. Because anyone can add new features and improve on existing ones, QGIS never
stagnates. The development of a new tool can happen as quickly as you need it to.

Extensive help and documentation is available. If you're stuck with anything, you can turn to the extensive
documentation, your fellow QGIS users, or even the developers.

Cross-platform. QGIS can be installed on MacOS, Windows and Linux.

Now that you know why you want to use QGIS, these exercises will make you know how.
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1.1.2 Hintergrund

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to
learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African
government and has been a phenomenal success, with people all over the world writing to us to tell us how they are
using the materials to run University Training Courses, teach themselves GIS and so on. The Gentle Introduction is not
a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning
about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application.
However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC. we frequently
run training courses and have realised that a third resource is needed - one that leads the reader sequentially through
learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.

Dieses Trainingshandbuch ist dafiir vorgesehen alle Materialien bereitzustellen, die fiir einen Kurs iiber 5 Tage
in QGIS, PostgreSQL und PostQIS notig sind. Dieser Kurs beinhaltet Inhalte fiir Anfinger, bereits vertraute und
fortgeschrittene Benutzer und besitzt ebenso viele Ubungen mit Antworten im Text.

1.1.3 Lizenz

@060

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti
and is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license
may be available at below.

Wir haben das QGIS Trainingshandbuch unter einer freien Lizenz veroffentlicht, was Thnen die Freiheit
bietet die Inhalte zu kopieren, modifizieren und zu verteilen. In einfachen Worten gesprochen gelten folgende
Nutzungsbedingungen:

* Es ist nicht erlaubt die Inhalte als eigene Arbeit darzustellen, urheberrechtlich Texte oder Namensnennungen
zu entfernen.

» Sie sind nicht berechtigt diese Arbeit und mehr eingeschréinkten Berechtigungen zu verteilen, als wie sie Thnen
zur Verfiigung gestellt wurde.

* Falls Sie weitere Inhalte zu dieser Arbeit hinzufiigen (zumindest ein komplettes Modul), dann koénnen Sie Thren
Namen am Ende der Autorenliste dieses Dokumentes einfiigen (Dieser wird auf der Startseite angezeigt)

* Falls Sie kleinere Anderungen beifiigen, dann tragen Sie IThren Namen bei Einzelne Mitwirkende ein.

* Falls Sie dieses Dokument komplett Ubersetzt haben, dann kénnen Sie ihren Namen in der Autorenliste in
Form von ,,Ubersetzt von Joe Bloggs* eintragen.

* Falls Sie ein Modul oder eine Lehreinheit gesponsert haben, dann kénnen Sie den Autor bitten eine Anmerkung
an den Beginn jeder beigetragenen Lehreinheit beizufiigen, z.B.:

Bemerkung: Diese Lektion wurde von Megacorp gesponsert.

¢ Falls Sie unsicher sind, wie Sie mit dieser Lizenz arbeiten konnen, dann kontaktieren Sie uns bitte unter:
office@linfiniti.com und wir beraten Sie, ob Ihr vorhaben in Ordnung ist.

* If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate
the profits to the QGIS project.

« Sie diirfen diese Arbeit nicht vermarkten, auSer mit der Erlaubnis der Autoren. Hierbei ist gemeint, dass die
Arbeit nicht zum Profit verkauft werden darf, wie das erstellen eines kommerziell abgeleiteten Werkes (z.B.
Inhalt an Magazine verkaufen). Die Ausnahme besteht darin, den gesamten Gewinn an das QGIS-Projekt
weiter zu leiten. Sie diirfen (und wir ermutigen Sie dazu) diese Arbeit als Lehrbuch zu verwenden, wen
Sie Kurse anbieten, selbst wenn diese kommerziell sind. Anders gesagt, selbstverstindlich diirfen Sie einen
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kostenpflichtigen Kurs anbieten und dieses Lehrbuch verwenden, aber Sie diirfen das Lehrbuch selber nicht
verkaufen - solche Gelder sollten an das QGIS-Projekt gehen.

1.1.4 Forderer

Diese Arbeit umfasst nicht die komplette Abhandlung der Dinge die mit QGIS getan werden konnen und wir
ermutigen euch Inhalte beizutragen, welche diese Liicken schlielen. Linfiniti Consulting CC. kann auf kommerzieller
Basis fiir Sie weitere Inhalte erstellten, diese werden jedoch unter der gleichen Lizenz verdffentlich.

1.1.5 Autoren

¢ Riidiger Thiede (rudi@linfiniti.com) - Rudi verfasste das QGIS Lehr- und Teile des PostGIS-Materials.

¢ Tim Sutton (tim@linfiniti.com) - Tim beaufsichtigte und leitete das Projekt, ebenso war er Mitverfasser des
PostgreSQL und PostGIS Abschnittes. Tim erstellte ebenso das Sphinxmotiv, welche fiir das Handbuch benutzt
wurde

* Horst Diister (horst.duester@kappasys.ch ) - Horst war Co-Autor in den Bereichen PostSQL und PostGIS

¢ Marcelle Sutton (marcelle@linfiniti.com) - Marcelle war Korrekturleser und gab Redaktionstipps wihrend der
Erstellung.

1.1.6 Einzelne Mitwirkende

Hier konnte Thr Name stehen!

1.1.7 Sponsoren

 Cape Peninsula University of Technology

1.1.8 Source files and Issue reports

The source of this document is available at GitHub QGIS Documentation repository. Consult GitHub.com for
instructions on how to use the git version control system.

Despite our efforts, you could find some errors or miss some information while following this training. Please report
them at https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Aktuelle Version

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS
documentation website (https://docs.qgis.org).

Bemerkung: The documentation website contains links to both online and PDF versions of the Training manual
and other parts of the QGIS documentation.
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1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

Warnung: This course includes instructions on adding, deleting and altering GIS datasets. We have provided
training datasets for this purpose. Before using the techniques described here on your own data, always ensure
you have proper backups!

1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.
Text that looks » like » this directs you through menus.

This kind of text refers to something you can type, such as a command.
This/kind/of.text refers to a path or filename.

This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in,
you can expect a different set of course outcomes. Each category contains information that is essential for the next
one, so it’s important to do all exercises that are at or below your level of experience.

\ Basic

In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the
operation of GIS software.

Limited theoretical background will be provided to explain the purpose of an action you will be performing in the
program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their
power via QGIS.

/ Intermediate

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.

Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware
of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn
how to use analysis functions in QGIS.

When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need
for everyday use.
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mm= Fortgeschritten
In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience
with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.

Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface
follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how
to make use of the QGIS plugin system, database access, and so on.

When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its
more advanced functions.

1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:
« Streets and Places datasets from OpenStreetMap (https://www.openstreetmap.org/)
¢ Property boundaries (urban and rural), water bodies from NGI (http://www.ngi.gov.za/)
e SRTM DEM from the CGIAR-CGI (http://srtm.csi.cgiar.org/)

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are
provided in the exercise_data folder.

If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in
the Vorbereitung der Ubungsdaten appendix.
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KAPITEL 2

Module: Erstellen und Erkunden einer einfachen Karte

In diesem Modul erstellen Sie eine grundlegende Karte, die spiter als Grundlage fiir weitere Demonstrationen der
QGIS-Funktionalitit verwendet wird.

2.1 Lesson: An Overview of the Interface

We will explore the QGIS user interface so that you are familiar with the menus, toolbars, map canvas and layers list
that form the basic structure of the interface.

The goal for this lesson: To understand the basics of the QGIS user interface.
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211 \ Try Yourself: The Basics

*Basic Map - QGIS 0c62abed96 [tm]

SNSAHS
<
‘3

e Coordinate|20.3420,-33.9989 |9 _Scale|1:32869 |~ | @ Magnifier 100% |2| Rotation [0.0° 2| v Render @ EpsGiu326 @)

The elements identified in the figure above are:

1. Layers List / Browser Panel

. Werkzeugkisten

. Map canvas

2
3
4. Status bar
5. Side Toolbar
6

. Locator bar

\ The Layers List

In the Layers list, you can see a list, at any time, of all the layers available to you.

Expanding collapsed items (by clicking the arrow or plus symbol beside them) will provide you with more information
on the layer’s current appearance.

Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference
system and the complete path of the location on your device.

Right-clicking on a layer will give you a menu with lots of extra options. You will be using some of them before long,

so take a look around!

Bemerkung: A vector layer is a dataset, usually of a specific kind of object, such as roads, trees, etc. A vector layer
can consist of either points, lines or polygons.
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\ The Browser Panel

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or Maplnfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or
MSSQL Spatial) and WMS/WES connections. You can also view your GRASS data.

If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path
of the project file under in the , Project Home item.
Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder,

right click on it and click on Add as a Favorite. Youshould then be able to see your folder in the Favorites
item.

Tipp: It can happen that the folders added to Favorite item have a really long name: don’t worry right-click on the
path and choose Rename Favorite. .. to set another name.

\ Toolbars

Your most often used sets of tools can be turned into toolbars for basic access. For example, the File toolbar allows
you to save, load, print, and start a new project. You can easily customize the interface to see only the tools you use
most often, adding or removing toolbars as necessary via the View » Toolbars menu.

Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the File toolbar (which contains the Save button), you can still save your map by clicking on the Project menu
and then clicking on Save.

\ The Map Canvas

This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the
visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the
next sections.

\ The Status Bar

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the
mouse cursor’s coordinates on the map.

\ The Side Toolbar

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But remember
that you can move all the toolbars wherever it is more comfortable for you.

2.1. Lesson: An Overview of the Interface 9
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\ The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks,
etc. Check all the different options in the locator_options section of the QGIS User Manual.

Tipp: With the shortcut Ct r1+XK you can easily access the bar.

2.1.2 \ Try Yourself 1

Try to identify the four elements listed above on your own screen, without referring to the diagram above. See if you
can identify their names and functions. You will become more familiar with these elements as you use them in the
coming days.

Check your results

21.3 \ Try Yourself 2

Try to find each of these tools on your screen. What is their purpose?

=]
1. =fg

2 5
3. BN

4. BRena’er

[—]

5.

Bemerkung: If any of these tools is not visible on the screen, try enabling some toolbars that are currently hidden.
Also keep in mind that if there isn’t enough space on the screen, a toolbar may be shortened by hiding some of its
tools. You can see the hidden tools by clicking on the double right arrow button in any such collapsed toolbar. You
can see a tooltip with the name of any tool by holding your mouse over the tool for a while.

Check your results

2.1.4 What’s Next?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some
common data types.
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2.2 Lesson: Adding your first layers

We will start the application, and create a basic map to use for examples and exercises.

The goal for this lesson: To get started with an example map.

Bemerkung: Before starting this exercise, QGIS must be installed on your computer. Also, you should have
downloaded the sample data to use.

Launch QGIS from its desktop shortcut, menu item, etc., depending on how you configured its installation.

Bemerkung: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup,
the screens you encounter may well appear somewhat different. However, all the same buttons will still be available,
and the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this
course.

Let’s get started right away!

2.2.1 \ Follow Along: Prepare a map

1. Open QGIS. You will have a new, blank map.

Untitled Project - QGIS [new]

Project Edit VWiew Layer Settings Plugins Vector Raster Database Web Processing Help
DEEBREEY O 2L "HP o8 01YR
LA VAL

Browser
QRYT*e
Favorites

» [5] Home
»

e
® o
Al
o

“®  Recent Projects

(]

@ GeoPackage

/ spatiaLite

@ Postais

P mssqQL

@ pB2

@ WMS/WMTS

» @ XvZTiles

@ wcs

@ WFs

@ ows

& ArcGisMapServer
& ArcGisFeatureServer
sk GeoNede

Layers (=]E)
« @ e T | =

L Type to locate (Ctrl+K) Ready Coordinate ¥ Scale| 11 ~ | @ Magnifier| 100% | Rotation | 0,0° | V| Render & EpsGi326 @

2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We'll use
it to load our dataset: click the ‘5 Open Data Source Manager {y,ttop

If you can’t find the icon, check that the Data Source Manager toolbar is enabled in the View » Toolbars menu.
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Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DEBRRRY Uapp  HD GO B #* 2 m-00 00
Yol W Ed ® 2

Browsy ©®  Recent Projects

Data Source Manager | Browser
Browser
QYo
~ ¢ Favorites

» [1 /media/TRAVAIL/2019/Controle
(a1 Home

- ¢ Vector

® WMS/WMTS
Raster
» @ xvzTiles - ’
Y/ =)
A% Mesh
* » @ GeoPackage

© ows ¢ Delimited Text /7 spatiaLite
@ ArcGisMapServer @ Postals
@ ArcGisFeatureserver 4 Geopackage » mssqQL
st GeoNode @ pB2
#,, SpatiaLite » @ WMS/WMTS
» @ XYZTiles
4 PostaresQL
e MSSQL » @
8 @ ArcGisMapServer
s DB2 @ ArcGisFeatureServer
i GeoNode
Layers o WA virtual Layer *
« il . T |2 = v =
& wms/wmts
& wes
a WFS
&
g ArcGIS Map Server
/2 ArcGIS Feature
Server
4 GeoNode
Q Type to locate (Ctrl+K) Ready Coordinate ¥ Scle| 11 ~ | @ Magnifier | 100% = Rotation [00° % V/Render & Epscaszs @

3. Load the protected_areas. shp vector dataset:

1. Click on the Vector tab.

2. Enable the - ® File source type.
3. Press the ... button next to Vector Datasel(s).

4. Select the exercise_data/shapefile/protected_areas.shp file in your training
directory.

5. Click Open. You will see the original dialog, with the file path filled in.
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B Browser

Vector

* Raster

</
_A_+ Mesh

* Delimited Text

"d GeoPackage

ey SpatialLite
* PostgreSQL
4 MSSQL

DB2
% DB2

m Virtual Layer

ﬁ WMS/WMTS
5@; WCs
g WFS
@ ArcGIS Map
# Server

ArcGIS Feature

Server

Data Source Manager | Vector
Source Type
(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.
Encoding System -

Source

Vector Dataset(s) exercise_data/shapefile/protected_areas.shp

@Help < Add # Close

6. Click Add here as well. The data you specified will now load: you can see a protected_areas item
in the Layers panel (bottom left) with its features shown in the main map canvas.

*Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DEBRERRY UeLL /i BPPRPRA RN &0 -5-8-5,58#% I =-0-

LA AN A TN

Browser B®
GRTHO
Favorites
» (6] Home
y [0/
@ GeoPackage
/# spatiaLite
@ Postals
» MmssQL
I pB2
@ WMS/WMTS
» @ XYZTiles
@ wcs
@ WFS
© ows
& ArcGisMapServer
& ArcGisFeatureServer
s§¢ GeoNode

Layers B®
Qe TEFAL
1 protected areas

Q Type to locate (CErl+K) Ready

an
= o ® -
Coordinate|20.3631,33.8948 | 9 Scale 1:76050 ~ | & Magnifier | 100% | Rotation |0,0° 5 V| Render & EPsc4326 @
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Congratulations! You now have a basic map. Now would be a good time to save your work.

1. Click on the Save As button: H=t3

2. Save the map under a solution folder next to exercise_data andcallit basic_map.ggz.

2.2.2 \ Try Yourself

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder
(exercise_data/shapefile) to the map.

Check your results

223 \ Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a
database management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use
of databases. GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.

The GeoPackage open format is a container that allows you to store GIS data (layers) in a single file. Unlike the ESRI
Shapefile format (e.g. the protected_areas. shp dataset you loaded earlier), a single GeoPackage file can
contain various data (both vector and raster data) in different coordinate reference systems, as well as tables without
spatial information; all these features allow you to share data easily and avoid file duplication.

In order to load a layer from a GeoPackage, you will first need to create the connection to it:

1. Click on the ‘! Open Data Source Manager ¢,

2. On the left click on the @ GeoPackage tab.

3. Click on the New button and browse to the training_data.gpkg file in the exercise_data folder
you downloaded before.

4. Select the file and press Open. The file path is now added to the Geopackage connections list, and appears in
the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.

1. Click on the Connect button. In the central part of the window you should now see the list of all the layers
contained in the GeoPackage file.

2. Select the roads layer and click on the Add button.
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Data Source Manager | GeoPackage

W srowser Connections
- g Vector training_data.gpkg@/media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg v
4 Raster New Remove
X1/
et W Table - Type Geometry column Sql
- ~ /media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg
4 Delimited Text buildings & MultiPolygon geom
% GeoPackage roads ' LineString  geem
i’:_ SpatiaLite
+ PostgreSQL
* MSSQL
082, pB2
m Virtual Layer
ﬁ WMS/WMTS
L5 wes
e WFS [ )

=
Also list tables with no geometry

.)‘4'- ArcGIS Map Server

ArcGIS Feature
Server

& GeoNode @Help Set Filter «/ Add % Close

Search options

A roads layer is added to the Layers panel with features displayed on the map canvas.
3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

224 \ Follow Along: Loading vector data from a SpatiaLite Database with
the Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an
extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described
above: Create the connection —> Enable it —> Add the layer(s).

While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.
1. Click the g icon to open the Data Source Manager window.

2. Click on the B Browser tab.

3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs
in the left. These allow quick access to connected databases or folders.

For example, click on the drop-down icon next to the 0 GeoPackage entry. Youll see the
training-data.gpkg file we previously connected to (and its layers, if expanded).

4. Right-click the lﬁ SpatiaLite entry and select New Connection....

5. Navigate to the exercise_data folder, select the landuse . sglite file and click Open.
Notice that a @ landuse.sqglite entry has been added under the SpatiaLite one.

6. Expand the @ landuse.sqlite entry.
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7. Double-click the - landuse layer or select and drag-and-drop it onto the map canvas. A new layer is added
to the Layers panel and its features are displayed on the map canvas.

Data Source Manager | Browser

_:_.- Browser Browser

QESTHO

B Vector

- Favorites
» [¥% Project Home
Raster

L » [a] Home
A% Mesh ey

® ~ @ GeoPackage

o Delimited Text ~ © training_data.gpkg
_ = buildings

if GeoPackage /" roads

~ / Spatialite

i"'; SpatiaLite * = landuse.sqlite

4 PostgresQL @ Postals
» mssqQL
» MS5QL @ DB2
@ WMS/WMTS
DB?!- S v B XYZ Tiles
iva =" OpenStreetMap
Lﬁ_ Virtual Layer & wcs
o i WFS
\ﬁi WMS/WMTS ) ows
£ wes & ArcGisMapServer
h & ArcGisFeatureServer
* WFS s}t GeoNode

%74 ArCGIS Map Server

ArcGIS Feature
* Server

» GeoMNode

Tipp: Enable the Browser panel in View » Panels » and use it to add your data. It’s a handy shortcut for the Data
Source Manager » Browser tab, with the same functionality.

Bemerkung: Remember to save your project frequently! The project file doesn’t contain any of the data itself, but
it remembers which layers you loaded into your map.

225 / Try Yourself Load More Vector Data

Load the following datasets from the exercise_data folder into your map using any of the methods explained
above:

* buildings
* water

Check your results
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2.2.6 Follow Along: Reordering the Layers

The layers in your Layers list are drawn on the map in a certain order. The layer at the bottom of the list is drawn

first, and the layer at the top is drawn last. By changing the order that they are shown on the list, you can change the
order they are drawn in.

Bemerkung: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel.
We will however not discuss this feature yet.

The order in which the layers have been loaded into the map is probably not logical at this stage. It’s possible that the
road layer is completely hidden because other layers are on top of it.

For example, this layer order...

Layers (=]ES]
o @l ® T & -5 &L

v [ water

v! [[] buildings

v| [ landuse

v| — roads

v — rivers

v| * places

v [] protected_areas

... would result in roads and places being hidden as they run underneath the polygons of the landuse layer.
To resolve this problem:

1. Click and drag on a layer in the Layers list.

2. Reorder them to look like this:

basic_map - QGIS X
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

CEBRRERY 02 2L HAPPLALABEDNRS & E-N-EE & [T
REV:AM /B R-ZT%E B =4 EHu LB %E R 2

Layers B®
« 3O T &R
places
v/ — roads
v/ — rivers
V! [[] buildings
V! [ water

v| ] protected_areas
v! [l landuse

Layers | Browser

£ L yd [ \
Q Type to locate (Ctrl+K) Coordinate | 20.4981,33.9741 |9§ scale 1:56077 |~ | @ Magnifier|100% <| Rotation |0.0° <| v/Render @ EPSG4326 @

You'll see that the map now makes more sense visually, with roads and buildings appearing above the land use regions.
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2.2.7 In Conclusion

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 What’s Next?

Now you're familiar with the basic function of the Open Data Source Manager button, but what about all the others?
How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface.
This is the topic of the next lesson.

2.3 Lesson: Navigating the Map Canvas

This section will focus on basic QGIS navigation tools used to navigate within the Map Canvas. These tools will allow
you to visually explore the layers at different scales.

The goal for this lesson: Learn how to use Pan and Zoom tools within QGIS and learn about map scale.

2.3.1 \ Follow Along: Basic Navigation Tools

Before learning how to navigate within the Map Canvas, let’s add some layers that we can explore during this tutorial.

1. Open a new blank project and using the steps learnt in Create a Map, load the previously seen
protected_areas, roads and buildings layers to the project. The result view should look similar to
the snippet in Abb. 2.1 below (colors do not matter):
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Q

O RN (UL HPP QY LT @ N-8-LhEHE -
BQVA®D  / = %= - @ @
9 12 px

Browser (=]
OR2THO
v [ VirtualBox
¢ vscode
’ 3D Objects
¢ Anaconda3
» AppMods
¢ Autodesk
» Contacts
¢ Desktop
» Documents
b Downloads
Dropbox (BOSTON UNIVERSITY)
1 eclipse
+ [ eclipse-workspace
Layers
o @ ® T &~8 0
v roads
v| [l buildings
v| [ protected areas

R )2
DoomnoooooOol

b

2

—

L Type to locate (Ctrl+K) 1leg 1| 20.2255-34.0416 |¥ ¢ 1:110950 |~ | @ r|100% $ 3 00¢ 3| V| Render @ gpsGi43ze @

Abb. 2.1: Protected areas, roads and buildings added

Let’s first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the @ Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let’s zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the 4*+’ Zoom In bystton,
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Left click and hold.

4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Abb. 2.2).
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Abb. 2.2: Zoom in

5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
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@ *Untitled Project - QGIS — O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DoBRREY IVPLHAPPI KA EBEOR &¢ K-8, EE-
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Browser (=]
QRETHO

b [ VirtualBox =
v [ wscode

b [ 3D Objects
+ [ Anaconda3
+ [ AppMods

v [ Autodesk
»

v

»

Y

»

»

[ Contacts

5 Desktop

[1 Documents 7

[ Downloads L= T

1 Dropbox (BOSTOMN UNIVERSITY) -

[ eclipse ]
|+ [ eclipse-workspace
Layers =] . X
i » T &8 7 O i

— roads : 7.6 -
M buildings ' - ol .-
[T protected areas ;

1]

[ Q Type tolocate (Ctr+K) | 1 204849,-33.9843 |¥ /132458 v | @ r[100% |5 3 [00°  [5][v/Render @ ePsciaize @

6. To zoom out, select the }9 Zoom Out byytton and perform the same action as you did for zooming in.

As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous
view.

1. In the Map Navigation Toolbar, click on ;a Zoom Last hytton to go to your previous view.

2. Click on }a Zoom Next bytton to proceed to move forward in your history.
Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use
the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the ﬂ Zoom Full Extent tyyon,

As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map
Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the Map
Canvas is to the actual object in the real world.
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Coordinate  20.6324,-34.0757 - Scale 1:128472 ~ | & Magnifier 100% +| Rotation |0.0° 5| v/ Render X @

You can also use this field to set the Map Scale manually.
1. In the Status Bar, click on the Scale textfield.

2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you
typed in.

3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

£
1:1000000 =

1:500000
1:250000
1:100000
1:50000
1:10000
1:5000
1:2500
1:1000 '~
b Scale|1:50000 v

4. Select 1:5000. This will also update the map scale in the Map Canvas.

Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to
learn about alternative ways of navigating the Map Canvas.

2.3.2 In Conclusion

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers.
This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: Symbologie

The symbology of a layer is its visual appearance on the map. The basic strength of GIS over other ways of representing
data with spatial aspects is that with GIS, you have a dynamic visual representation of the data you’re working with.

Therefore, the visual appearance of the map (which depends on the symbology of the individual layers) is very
important. The end user of the maps you produce will need to be able to easily see what the map represents. Equally
as important, you need to be able to explore the data as you're working with it, and good symbology helps a lot.

In other words, having proper symbology is not a luxury or just nice to have. In fact, it’s essential for you to use a GIS
properly and produce maps and information that people will be able to use.

The goal for this lesson: To be able to create any symbology you want for any vector layer.
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2441 \ Follow Along: Changing Colors

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the landuse layer.
1. Right-click on the landuse layer in the layers list.

2. Select the menu item Properties... in the menu that appears.

Bemerkung: By default, you can also access a layer’s properties by double-clicking on the layer in the Layers
list.

Tipp: The % button at the top of the Layers panel will open the Layer Styling panel. You can use this panel
to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the d Symbology tab:

Layer Properties - landuse | Symbology
[ Zsingle symbol -]

@ nformation Fc |k

. [ simple fill

:‘{:‘\_\ Source

Q’ Symbology
€ Labels
BB Masks unit | Millimeters =
S Opacity 1 100,0% |+
, Diagrams .
Color | H
NF 3D View
E Fields
E Attributes Form | @ Favorites -| 8z
Joins
ﬁ Auxiliary Storage -I -
@ Actions , . . . .
gradient gray 3 fill hashed black / hashed black\,  hashed black X outline blue outline green outline red
. plasma
, Display
: r
‘ Rendermg : @ - - -
{ L
Variables
- outline xpattern pattern dot pattern zelda simple blue fill  simple greenfill  simple red fill
a Metadata black
"™ Dependencies Eil= |save Symbol...| Advanced ~|
Legend » Layer Rendering
& oais server _| @Help || style - | «/Apply | % cancel H oK ]

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Choose a gray color and click OK.

6. Click OK again in the Layer Properties window, and you will see the color change being applied to the layer.
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24.2 \ Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Check your results

243 \ Follow Along: Changing Symbol Structure

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the
lines between the different land use areas so as to make the map less visually cluttered.

1. Open the Layer Properties window for the landuse layer.
Under the d Symbology tab, you will see the same kind of dialog as before. This time, however, you’re doing
more than just quickly changing the color.

2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.

3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.
4. Change this to No Pen.

Layer Properties - landuse | Symbology

| & single symbol

G‘ Information ~ [ Fill |ﬁ|

simple Fill
N :
N Source —
=Rl
& symbology
€3 Labels
€D Maske symbol layer type| simple Fill - |
: i .
Diagrams Fill color | H &
Fill skyl solid v
Nf 3D View syle | NI -| =
stroke color | (I - .
E Fields -
Stroke width | 0,260000 2| | Millimeters  ~| €&
E Attributes Form
Stroke style | Mo Pen M=
Joins Joinstyle | F Bevel K="
E’i Auxiliary Storage X | 0,000000 -
Offset  Millimeters - |
LB Actions y 0,000000 E
- Display v| Enable symbol layer =, Draw effects
& Rendering
P Layer Rendering
Variables _| @Help || style -| | «/Apply || % cancel |[ «/ OK ]

5. Click OK.
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Now the landuse layer won’t have any lines between areas.

244 \ Try Yourself

* Change the water layer’s symbology again so that it has a darker blue outline.

¢ Change the rivers layer’s symbology to a sensible representation of waterways.
Remember: you can use the (\{ Open the Layer Styling panel by tton and see all the changes instantly. That panel also allows
you to undo individual changes while symbolizing a layer.

Check your results

245 / Follow Along: Scale-Based Visibility

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents may
have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the dataset
at inappropriate scales.

In our case, we may decide to hide the buildings from view at small scales. This map, for example. ..

symbology - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

0 BERDEY Oa e mRDDogaila e -G-N-,BEE X =~ [0
‘BE VAW VBRE-Z0=<8 B =QEgEggE @ & « X

Layers @
¢ i % T &~

vl = places

v| — roads

V| — rivers

v [7] bulldings

v/ [ ] water

W protected_areas

v landuse

Layers = Browser

Q Type to locate (Ctrl+K) sordinal| 207122339589 |9 zal|1:150104 |~ | @ agnifi 100% </ otatic |0.0° | ¥ Render & EPSGid326 @

... is not very useful. The buildings are hard to distinguish at that scale.
To enable scale-based rendering:

1. Open the Layer Properties dialog for the buildings layer.

2. Activate the f Rendering tab.
3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
4. Change the Minimum value to 1:10000.
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Layer Properties - buildings | Rendering >

v |v| Scale Dependent Visibility

q’ L Minimum (exclusive) Maximum (inclusive)
4= [1:10000 - |[&| P o - ||m
" Source
v| Simplify G b
& Symbology mplify Geometry
Note: Feature simplification may speed up rendering but can result in rendering inconsistencies
€3 Labels S . . - e N -
Simplification threshold (higher values result in more simplification) 1,00 pixels
€D Masks simplification algorithm Distance ~
Diagrams
‘4; 3D View Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -
E Fields Force layer to render as a raster (may result in smaller export file sizes)
E Attributes Form Refresh layer at interval (seconds)

, Refresh layer on notification
Joins

ﬁ Auxiliary Storage
{;'.-Q Actions
, Display

@’ Rendering

5. Click OK.

Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and reappears.

Bemerkung: You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a
window:

Y=

2.4.6 / Follow Along: Adding Symbol Layers
Now that you know how to change simple symbology for layers, the next step is to create more complex symbology.
QGIS allows you to do this using symbol layers.

1. Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).

In this example, the current symbol has no outline (i.e., it uses the No Pen border style).
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f}' Information

‘}S,‘_- Source

ﬂ’ symbology

€3 Labels

B Masks

. Diagrams

Wf 3D View
B Fielas

E Attributes Form

Joins

ﬂ Auxiliary Storage
@ Actions
. Display

& f Rendering

Variables

Layer Properties - landuse | Symbology

| = Single symbol -]

v [ Fill | & |
Simple Fill —
el
symbol layer type| Simple Fill |
Fillcolor | M |;| LEE
Fill style [ solid - &
stroke color | (. - .
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
Stroke style | No Pen K=t
Join style |a Bevel - | =i
X | 0,000000 E
Offset ' Millimeters - |
y  0,000000 2]

v| Enable symbol layer =, Draw effects

P Layer Rendering
@Help || style -|

| Japply || ®cancel || JoK |

2. Select the Fill level in the tree and click the Ifl-l:l-l:| Add symbol layer ytton, The dialog will change to look something
like this, with a new symbol layer added:
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Layer Properties - landuse | Symbology >

= Single symbol =
"’;’ Information ~ H Fill
Simple Fill =l
33 source . [X simple Fill .
' =E
& symbology
€= Labels
symbol layer type Simple Fill -
D Masks Y ver typ s
. i O
S Fill color [=h
Fill style I solid -
WF 3D View 2 &
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 -
Offset Millimeters -
U_@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer 4=, Draw effects
Qj,/ Rendering
» Layer Rendering
e dblee @Help Style -~ « Apply || % cancel «/ OK

-

It may appear somewhat different in color, for example, but you're going to change that anyway.

Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of symbol.
Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Bemerkung: It’s important not to get confused between a map layer and a symbol layer. A map layer is a vector (or
raster) that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This
course will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to
prevent confusion.

With the new Simple Fill symbol layer selected:
1. Set the border style to No Pen, as before.

2. Change the fill style to something other than Solid or No brush. For example:
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Layer Properties - landuse | Symbology

- |

| = single symbol

f'i' Information ~ [ Fill |§|

Simple Fill — =
‘:{:\) Source [T simple Fill :%: :%:
]
& symbology -
€= Labels
€D Masks symbol layer type| Simple Fill - |
: i (.
S Fill color | H <
Fill skyl i cross -
WF 3D View term | _| =
stroke color | (. - <.
E Fields -
Stroke width | 0,260000 @ || Millimeters  ~ | &,
E Attributes Form
Stroke style | No Pen - &
Joins Joinstyle | T Bevel - &
ﬁ Auxiliary Storage % | 0.000000 |:
Offset | Millimeters - |
L Actions y |0,000000 S —
® oisplay v| Enable symbol layer =, Draw effects
q. Rendering
» Layer Rendering
R _| @Help || style ~| | «/Apply || % cancel H </ oK ]

3. Click OK.

Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create
a kind of texture for your layer that way.

O |- |
4 simple Fill
IF simple Fill
] simple Fill

It’s fun! But it probably has too many colors to use in a real map...

247 / Try Yourself

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using the
methods above.

Check your results
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2438 A Follow Along: Ordering Symbol Levels

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers
are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected results.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Give the base line a Stroke width of 1 . 5 and a black color.
3. Give the new, uppermost layer a thickness of 0. 8 and a white color.

You'll notice that this happens:

Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s
not what we want at all!

To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different
symbol layers are rendered.

To change the order of the symbol layers:
1. Select the topmost Line layer in the symbol layers tree.

2. Click Advanced w Symbol levels... in the bottom right-hand corner of the window.
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Layer Properties - roads | Symbology "

Q = single symbol =
@ information %
simple line
33 source == Simple line
& symbology
€€ Labels
Unit Millimeters >
B Masks .
Opacity _11100,0% v
", Disgrams Color | -
@& .
3D View
alg width | 1,50000 =RES
E Fields
. (73
E Attributes Form . Favorites a|~| 8
Joins
ﬁ Augxiliary Storage
{;'.-® Actions dash black dash blue dash green dash red
- Display Sl v
i Save Symbol...
4 Rendering symboly evels...

_ b Layer Rendering v| Clip Features to Canvas Extent
Variables _ | @Help Style ~ « Apply || % Cancel < OK

This will open a dialog like this:

symbol Levels x

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help % Cancel

3. Check A Enable symbol levels. You can then set the layer order of each symbol by entering the corresponding
level number. O is the bottom layer.
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In our case, we just want to activate the option, like this:

Symbol Levels

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer 0 Layer 1
= () 1

% cancel |[_Jok_|

This will render the white line above the thick black line borders:
4. Click OK twice to return to the map.

The map will now look like this:

N\

When you’re done, remember to save the symbol itself so as not to lose your work if you change the symbol again

in the future. You can save your current symbol style by clicking the Save Style... button at the bottom of the Layer
Properties dialog. We will be using the QGIS QML Style File format.
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Save your style in the solution/styles/better_roads.qgml folder. You can load a previously saved style
at any time by clicking the Load Style... button. Before you change a style, keep in mind that any unsaved style you
are replacing will be lost.

2.4.9 / Try Yourself

Change the appearance of the roads layer again.

Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that
you may need to change the layer rendering order via the Advanced w» Symbol levels... dialog.

Check your results

2.4.10 s Try Yourself
Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered
classification yet, you will work with some rudimentary pre-classified data.

1. Create a new project and add only the roads dataset.

2. Apply the style file advanced_levels_demo.gml provided in exercise_data/styles to the
layer. This can be done through the Style » Load Style... combobox at the bottom of the Layer Properties
dialog.

3. Zoom in to the Swellendam area.

4. Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:
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Check your results

2.4.11 / Follow Along: Symbol layer types

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The
only type we’ve been using up to now was the Simple Fill type. The more advanced symbol layer types allow you to
customize your symbols even further.

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types
available for points.

Point Symbol Layer Types

1. Uncheck all the layers except for places.

2. Change the symbol properties for the places layer:
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Layer Properties - places | Symbology
| = single symbol

"i Information

@ Simple marker

‘:{Q} Source

Q/ Symbology

€3 Labels
B Masks Unit | Millimeters -
_ Opacity 1/100,0% |7
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Color | I'|
- . -
ug 3D View Size  |2,00000 BKEE
E Fields Rotation | 0,00° EEKES
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Joins
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- Display
' Rendering B @
0}

Variables
shield disability topo hospital  topo pop capital

| Metadata

(| = 'save Symbol... |Advanced -

Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. You can access the various symbol layer types by selecting the Simple marker layer in the symbol layers tree,
then click the Symbol layer type dropdown:
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker
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rd .
4  Rendering VCenter MRS
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[ Metadata
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ﬁ Dependencies £ a O O |_| I\ /] “ a -

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Investigate the various options available to you, and choose a symbol with styling you think is appropriate.

5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3. 00 and a Stroke
width of 0. 5.

Line Symbol Layer Types

To see the various options available for line data:

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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2. Select the Simple marker layer in the symbol layers tree. Change the symbol properties to match this dialog:
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3. Select the Marker line layer and change the interval to 1.00:
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4. Ensure that the symbol levels are correct (via the Advanced w Symbol levels dialog we used earlier) before
applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change direction
along with the road but don’t always bend along with it. This is useful for some purposes, but not for others. If you
prefer, you can change the symbol layer in question back to the way it was before.

Polygon Symbol Layer Types

To see the various options available for polygon data:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Investigate what the different options on the list can do.
3. Choose one of them that you find suitable.

4. If in doubt, use the Point pattern fill with the following options:
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5. Add a new symbol layer with a normal Simple fill.
6. Make it the same light blue with a darker blue border.

7. Move it underneath the point pattern symbol layer with the Move down button:
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As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size, shape
and distance of the individual dots that make up the texture.

2412 / Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Check your results

2.4.13 === Follow Along: Geometry generator symbology
You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol
depends directly on the layer type.

Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology
itself. For example you can run a real centroid spatial operation on a polygon layer without creating a point layer.

Moreover, you have all the styling options to change the appearance of the resulting symbol.
Let’s give it a try!
1. Select the water layer.

2. Click on Simple fill and change the Symbol layer type to Geometry generator.
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3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we
are going to create centroids for each feature, so change the Geometry Type to Point / Multipoint.

4. Now let’s write the query in the query panel:

centroid ($geometry)
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5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a spatial
operation within the layer symbology itself, isn’t that amazing?
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With the Geometry generator symbology you can really go over the edge of normal symbology.

mm= Try Yourself
Geometry generator are just another symbol level. Try to add another Simple fill underneath the Geometry generator
one.
Change also the appearance of the Simple marker of the Geometry generator symbology.

The final result should look like this:
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Check your results

2414 == Follow Along: Creating a Custom SVG Fill

Bemerkung: To do this exercise, you will need to have the free vector editing software Inkscape installed.

1. Start the Inkscape program. You will see the following interface:
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You should find this familiar if you have used other vector image editing programs, like Corel.
First, we’ll change the canvas to a size appropriate for a small texture.
2. Click on the menu item File » Document Properties. This will give you the Document Properties dialog.
3. Change the Units to px.
4. Change the Width and Height to 100.
5. Close the dialog when you are done.
6. Click on the menu item View » Zoom » Page to see the page you are working with.
7. Select the Circle tool:
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8. Click and drag on the page to draw an ellipse. To make the ellipse turn into a circle, hold the Ctr1 button
while you're drawing it.

9. Right-click on the circle you just created and open its Fill and Stroke options. You can modify its rendering,
such as:

1. Change the Fill color to a somehow pale grey-blue,
2. Assign to the border a darker color in Stroke paint tab,

3. And reduce the border thickness under Stroke style tab.
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10. Draw a line using the Pencil tool:

1. Click once to start the line. Hold Ct r1 to make it snap to increments of 15 degrees.

2. Move the pointer horizontally and place a point with a simple click.

3. Click and snap to the vertex of the line and trace a vertical line, ended by a simple click.
4. Now join the two end vertices.
5

. Change the color and width of the triangle symbol to match the circle’s stroke and move it around as
necessary, so that you end up with a symbol like this one:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is in,
under exercise_data/symbols, as SVG file.

In QGIS:
1. Open the Layer Properties for the 1anduse layer.
2. In the ‘Q*/ Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill™™
shown below.
3. Click the ... button and then Select File... to select your SVG image.

It’s added to the symbol tree and you can now customize its different characteristics (colors, angle, effects,
units. ..).
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Once you validate the dialog, features in landuse layer should now be covered by a set of symbols, showing a texture
like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set in the
layer properties a bigger Texture width.
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2.4.15 In Conclusion

Changing the symbology for the different layers has transformed a collection of vector files into a legible map. Not
only can you see what’s happening, it’s even nice to look at!

2.4.16 Further Reading

Examples of Beautiful Maps

2.4.17 What's Next?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available to
someone reading these maps. What are the streets called? Which administrative regions do certain areas belong to?
What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will explain
how to represent this data on your map.

Bemerkung: Did you remember to save your map recently?
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KAPITEL 3

Module: Vektordaten klassifizieren

Das Klassifizieren von Vektordaten ermdglicht es Thnen, den Elementen (verschiedene Objekte im selben Layer) in
Abhingigkeit von ihren Attributen unterschiedliche Symbole zuzuordnen. Auf diese Weise kann jemand, der die
Karte benutzt, die Attribute verschiedener Elemente leicht erkennen.

3.1 Lesson: Vector Attribute Data

Vector data is arguably the most common kind of data in the daily use of GIS. The vector model represents the location
and shape of geographic features using points, lines and polygons (and for 3D data also surfaces and volumes), while
their other properties are included as attributes (often presented as a table in QGIS).

Up to now, none of the changes we have made to the map have been influenced by the objects that are being shown.
In other words, all the land use areas look alike, and all the roads look alike. When looking at the map, the viewers
don’t know anything about the roads they are seeing; only that there is a road of a certain shape in a certain area.

But the whole strength of GIS is that all the objects that are visible on the map also have attributes. Maps in a GIS
aren’t just pictures. They represent not only objects in locations, but also information about those objects.

The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 \ Follow Along: Viewing Layer Attributes
It’s important to know that the data you will be working with does not only represent where objects are in space, but
also tells you what those objects are.

From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded,
then you can find the protected_areas. shp ESRI Shapefile format dataset in directory exercise_data/
shapefile.

The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected
areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.

[===]
2. In the Aftributes Toolbar click the Open Attribute Table yy¢ton - This will open a new window showing the
attribute table of the protected_areas layer.
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full_id osm_id osm_type boundary is_in leisure name type wikidata
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884
2 w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL

1

T show All Features _

Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.

wil

en:Bc

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column is
called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells
are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar

with them.

In the protected_areas layer, there are two features, which are represented by the two polygons we see

on the Map Canvas.

Bemerkung: In order to understand what the fields and attribute values represent, one may need to find
documentation (or metadata) describing the meaning of the attribute values. This is usually available from the

creator of the data set.

1. Go back to the main QGIS window.

3. Make sure the protected_areas layer is still selected in the Layers panel.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Attribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *

/ 2 B 0§ LT ES P PE EDe

full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884
2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ
L) L3

| 7 show All Features _ 2|8
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You can also select a feature using the Attribute Table.

1. Inthe Attribute Table window, on the far left, click on the row number of the record that is currently not selected.

Q protected_areas : Features Total: 2, Filtered: 2, Selected: 1 — Oa X
> ® 08 T E S P e = Fe

full id osm id osm tvpe boundary i5 in leisure name type wikidata Wi
() r2855697 2855697 protected_a... |Western Ca... |nature_reser... |Bontebok N...

187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL MNULI

[4 b

T show All Features _

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons
colored yellow.
3. To deselect the feature, go to the Attribute Table window and click on D-u] Deselect all features from the layer ¢y

Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected
from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

= I
Q protected_areas :: Features Total: 2, Filte
/ " B &
~ full id osm id osm tvpe
1- Select All

2/ w1870559

Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

You should see the polygon flash red a few times. If you missed it, try it again.
Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Aftribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Zoom to Feature
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() protected_areas :: Features Total: 2, Fi

= g g

full id osm id osm tvi

JOCCo0T

il r23855697 -
’ Select All

2/ w1870559
Copy Cell Content

Zoom to Feature

Pan to Feature

Flash Feature

Open Form

Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.

You may now close the attribute table.

3.1.2 \ Try Yourself Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?
2. Tell us a bit about the t own places in your dataset.

3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form,
and why?

Check your results

3.1.3 In Conclusion

You now know how to use the attribute table to see what is actually in the data you’re using. Any dataset will only
be useful to you if it has the attributes that you care about. If you know which attributes you need, you can quickly
decide if you're able to use a given dataset, or if you need to look for another one that has the required attribute data.

3.1.4 What’s Next?

Different attributes are useful for different purposes. Some of them can be represented directly as text for the map
user to see. You'll learn how to do this in the next lesson.
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3.2 Lesson: Labels

Labels can be added to a map to show any information about an object. Any vector layer can have labels associated
with it. These labels rely on the attribute data of a layer for their content.

The goal for this lesson: To apply useful and good-looking labels to a layer.

3.2.1 \ Follow Along: Using Labels

First, ensure that the ‘=k=| button is visible in the GUI:
1. Go to the menu item View » Toolbars

2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item
to activate it.

3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the ‘2zl toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to ‘2tz Single Labels

You'll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the name field was the most suitable one for this purpose.

6. Select name from the Value list:
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Layer Styling %]
o places -

= Single Labels - | |4
b

Value |abc name ~ || E

-

abe i abe abc . J

Text

Font | MS ShellDig 2 | S

Style Regular = @
UE[sE BE I€&

Size | 10.0000 | &
Paints | S

coor | (GGG - <.

Dpaﬂt? __l IDD.D E‘ru -

Tl Favorites v | 8
= Save Settings...

| e v Live update apply

7. Klicken Sie auf Anwenden

The map should now have labels like this:
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SRR ISR
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Font  |Ms Shel Dig 2 MK =S

| abe
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1" Spatial Bookmarks
[ Project Home
[é2] Home
e
" GeoPackage
f SpatiaLite
@ postGls
P mssaL
DB2
B wms wmTS
ﬂ Wector Tiles
I XVZ Tiles
@ wes
() WFS / OGC API - Feature.
) ows
& ArcGisMapServer
p=4

NP AP
4 3
Layers @®
|i“@ ® T &~ »
v| @ places
v roads
v rivers
v| M buitdings
v . ‘water

v . protected_areas
v landuse

Stile | Regular ME=S
u&s € 8l&|lr&
Size | 10.0000 BESE
| Paints - | S
cor [ - =,
Opacity —:Hm\ [=h

avorites :i
| O Favorite al~| 8

v vy owow

El [cave settings..|
|E\ |E\ Vllveupdate | Apply |

| @ Type to locate (ctl+k) Coordinate| 20,5409,-33.9529 W Scale 1:59610 v | (@ Magnifier | 100% |2] Rotaton [0.0° 2| W/Render @ EpsGiazes @

3.2.2 \ Follow Along: Changing Label Options

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately
formatted and either overlap or are too far away from their point markers.

Bemerkung: Above, you used the button in the Label Toolbar to open the Layer Styling panel. As with
Symbology, the same label options are available via both the Layer Styling panel and the Layer Properties dialog.
Here, you'll use the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the ‘=E2| Labels tab

3. Make sure Text is selected in the left-hand options list, then update the text formatting options to match those
shown here:
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@ Layer Properties - places | Labels
- =1 Single Labels

Information Value | abc name

=lE
w Text Sample
Source
Lorem Ipsum
Symbolo ore psu
Labels b
Lorem Ipsum # | |usesw | v | (B |- v
D Masks E— -
Diagrams 2% Formatting | Font [ Arial ay=
8Be [uffer
Fields 8¢ Mask Style  |Regular K=t
Attributes Form . Background Q Ev S Ev B Ev r Ev
Shadow
. :.f Sze  |13.0000 e
Joins / Callouts
1':0 Placement Foints - E-
iliary Storage 4 .
. Renderin
. P oo | | =L
Actions
Opadity 1| 100.0 % | &
Display
. Favorites ~| &

Rendering

Variables

Metadata

Dependencies

Legend

OGIS Server

Save Settings...

Style * 0K, Cancel Apply Help

4. Klicken Sie auf Anwenden

That font may be larger and more familiar to users, but its readability is still dependent on what layers are
rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list

6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:
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@ Layer Properties - places | Labels x
Q | =1 Single Labels = | |E|
3 Value |ib< name - | |E|

w Text Sample

Lorem Ipsum
{abe| Labels _— S !
|Lorem Ipsum |2| |1:50810 | ¢ | |m|v| | |+
b Bl B S ——
Ll abe Text Buffer
e Formatting V| Draw textbuffer (=],
= = Size | 1.0000 2 €
= abe Mask
-0 @ Background | Millmeters ~| S
=0 _
J Shadow Color | ==t
aho =
/ Callouts
Y V| Color buffer's fill
#y¥ Placement
7 Rendering Oparity 1] 100.0 % | &
) Pen join style | B Bevel = | =l
Blend mode |Normal - | @
Draw effects
L%
¥
+| stle | oK | | cancel ||  Apply [ Help |

7. Klicken Sie auf Anwenden

You'll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the
map:
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Now we can address the positioning of the labels in relation to their point markers.
8. Select Placement from the left-hand options list

9. Select Around point and change the value of Distance to 2 . 0 Millimeters:
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@ Layer Properties - places | Labels
Q =1 Single Labels -

q Information Value | abs name - || &

w Text Sample

J{:\‘.- Source

.“' Symbology Lorem |pGLIITI
Labels b
Lorem Ipsum | (142258 |- | |BF|~ v
D Masks o Placement
‘I Diagrams 2% Farmatting
8Be [uffer
E Fields abe! pask Cartographic '®' Around point Offset from point
Back d
E Attributes Form . ackgroun
- Shadow
. abe
Joins Callouts
/, Distance | 2.0000 -
. #y¥ Placement
E' Auxiliary Storage ] .
- ’ o ! Rendering Milimeters v @

G@ Actions Duadrant EL
- Display

4
4 Rendering

__ v Geometry generator
Variables

E Metadata
ﬁ’ Dependencies

Point / MultiPoint
Legend

— w Data defined
QGIS Server

“ L Coordinate X E, ¥ E,
Digitizing -

Style * 0K, Cancel Apply Help
W ne —

10. Klicken Sie auf Anwenden

You'll see that the labels are no longer overlapping their point markers.

3.2.3 / Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points inthe places
layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a
large scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.
1. Open the ‘2| Labels tab of the Layer Properties dialog for the places layer

2. Select the Placement option from the options list
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3. Click on the Offset from point button

This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:

@ Layer Properties - places | Labels x
Q =1 Single Labels M | |¢T|
N —
Value |ib< name - | | € |
w Text Sample
-
Lorem Ipsum
{abe| Labels _— i b
|Lorem Ipsum |3| |142259 |- | |ﬁ:«.|'| | |:|
abc -
abe Text Placement
2% Formatting =
- 8Be [uffer
= abe hask () Cartographic | Around point (@) Offset from point
= . Background
us - Shadow
ape Callouts g | pape— | p—
:,’ Quadrant | @dl | @be || @ | €
's? Placement =
“ Rendering ||||||
) | [ gl || |
Offset X,¥ | 0.0000 |2 0.0000 BEEE
|Mil|imeters . | @
Rotation | 0,007 =
v Geometry generator
] b
L% Point / MultiPoint -
¥ w Data defined b’
| stle - ok || cancel || Apply || hHep |

4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of the Marker size to 0 . 0:
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@ Layer Properties - places | Symbology

Q

E Single symbal

¥ Symbology

- Marker |¥|
Simple marker —

abe
abs Unit | Milimeters - |
Opacity | 00.0% <l
Color | I:l
= Sze | p.00000 BEEE
B Rotation | 0,00 ° B ="
L Favarites a -| &
® ° ® O ® ® ¥
dot black dot white dot blue dot green dot red effect drop
shadow
& ® ©
shield disability topo hospital topo pop capital
i/ |_| E Save Symbol . | | Advanced ~ |
v b Layer Rendering
= | style - | oK | | cancel || Apply [ Help |
5. Click Apply and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times
you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover

in a later exercise in this lesson. For now, zoom out and click on the button in the toolbar and see what happens.

3.24 / Try Yourself Customize the Labels

* Reset the label and symbol settings to have a point marker and a label offset of 2 . 0 Millimeters.
Check your results

* Set the map to the scale 1: 2100000. You can do this by typing it into the Scale box in the Status Bar. Modify
your labels to be suitable for viewing at this scale.

Check your results
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3.25 / Follow Along: Labeling Lines

Now that you know how labeling works, there’s an additional problem. Points and polygons are easy to label, but what
about lines? If you label them the same way as the points, your results would look like this:
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We will now reformat the roads layer labels so that they are easy to understand.
1. Hide the places layer so that it doesn’t distract you
2. Activate Single Labels for the roads layer as you did above for places
3. Set the font Size to 10 so that you can see more labels
4. Zoom in on the Swellendam town area

5. In the Labels tab’s Placement tab, choose the following settings:
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@ Layer Properties - roads | Labels
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You'll probably find that the text styling has used default values and the labels are consequently very hard to
read. Update the 7ext to use a dark-grey or black Color and the Buffer to use a light-yellow Color.

The map will look somewhat like this, depending on scale:
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You'll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select Merge connected lines
to avoid duplicate labels as shown:
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@ Layer Properties - roads | Labels
- =1 Single Labels

Information Value | abc name

w Text Sample

Source

Lorem Ipsum
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€D Masks
abe Text
Diagrams "% Formatting
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Back d
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7 Shadow
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liary Storage / T
Actions
Display
Rendering
Variables
Metadata
Dependencies
Legend
QaGls
Digitizing
Style v
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Show label @ Always show @.

Show upside-down labels
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w Feature options

Label every part of multi-part features
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Limit number of features to be labeled to
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Suppress labeling of features smaller than

5.00 mm

oK Cancel

Apply

L1

L

7. Klicken Sie auf OK

Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than ... to 5.00 mm and
note the results when you click Apply

Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in
this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab

Here’s the result:
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As you can see, this hides some labels that were previously visible, because of the difficulty of making some of them
follow twisting street lines while still being legible. It makes other labels much more useful since they track the roads
rather than float in space between them. You can decide which of these options to use, depending on what you think
seems more useful or what looks better.

3.2.6 & Follow Along: Data Defined Settings

1. Deactivate labeling for the roads layer

2. Reactivate labeling for the places layer

3. Open the attribute table for places via the ==/ button

It has one field which is of interest to us now: place which defines the type of urban area for each record.
We can use this data to influence the label styles.

4. Navigate to the Text panel in the places Labels panel

5. Click the \= button next to the Italic text button beneath Style and select Edit... to open the Expression String
Builder:
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@ Expression String Builder

Expression Function Editor
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Math
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String

User expressions
Variables

Recent (generic)

Show Help

Ok Cancel Help

6. Under Fields and Values, double click on place and then click All Unigue. This will list all unique values of
the place field of this layer. Add a = in the text editor and then double click on t own.

Alternatively, you can type: "place"

7. Click OK twice:

= 'town' directly in the text editor.

Q@ Expression String Builder

Function Editor

B L
o "town’

Expression

= e - L= e
Expected format: bool [1=True|0=False]
Feature «Mational Park Reception & Shop | ~

Preview: 0
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{d vy v v ¥vw¥vovw

rF T T T rorw
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Color
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Date and Time
Fields and Values
abe fyll_id
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abc name
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abe wikipedia
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Fuzzy Matching
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Map Layers
Maps
Math

Show Values

group field

Double-click to add field name to expression
string.

Right-Click on field name to open context
menu sample value loading options,
Loading field values from WF5 layers isn't
supported, before the layer is actually
inserted, ie. when building queries.

Values | ©L Search..

All Unique 10 Samples

hamlet
locality
suburb
town

Ok

Cancel

Help

Notice that the labels for all places whose place field matches t own are displayed in italics.
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3.2.7 A Try Yourself Using Data Defined Settings

Bemerkung: We're jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level,
it’s assumed that you’ll know what the following means. If you don'’t, feel free to leave out this section and come back
later when you’ve covered the requisite materials.

1. Open the Attribute Table for places
2. Enter edit mode by clicking the i button

3. Add a new column with the button

4. Configure it like this:
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=) Add Field >
Name FONT _SIZE

Comment

Type Decimal number (real) -

Provider type double

Ll

Length 3

qip

Precision 1

K Cancel

5. Use this to set custom font sizes for each different type of place (each key in the place field)

Check your results

3.2.8 === Further Possibilities With Labeling

We can’t cover every option in this course, but be aware that the Label tab has many other useful functions. You
can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using layer
attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute fields
allocated for the purpose), then edit these properties using the tools adjacent to the main Layer Labeling Options
button:

_— ﬂ nb& lzl_:_E‘h al L -bé abg
(These tools will be active if the required attribute fields exist and you are in edit mode.)

Feel free to explore more possibilities of the labeling system.

3.2.9 In Conclusion

You've learned how to use layer attributes to create dynamic labels. This can make your map a lot more informative
and stylish!

3.2.10 What’s Next?

Now that you know how attributes can make a visual difference for your map, how about using them to change the
symbology of objects themselves? That’s the topic for the next lesson!

3.3 Lesson: Klassifikation

Labels are a good way to communicate information such as the names of individual places, but they can’t be used for
everything. For example, let us say that someone wants to know what each 1anduse area is used for. Using labels,
you would get this:
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This makes the map’s labeling difficult to read and even overwhelming if there are numerous different landuse areas
on the map.

The goal for this lesson: To learn how to classify vector data effectively.

3.3.1 \ Follow Along: Classifying Nominal Data

1. Open the Layer Properties dialog for the 1anduse layer
2. Go to the Symbology tab

3. Click on the dropdown that says Single Symbol and change it to Categorized:
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Layer Properties - landuse | Symbology

| = Categorized

"i Information Value | =
Symbol (1 |E|

‘:{:\? Source

Color ramp | Random colors E|

& symbology

€€ Labels

B Masks

symbol = Value Legend

- .
. [MELEINE

N7 3D View

E Fields

Attributes
Form

Joins

% Auxiliary
< B storage

@ Actions
- Display

| Classify ||E| |E||DeleteAll| |Advanced ~ |
P Layer Rendering
@relp || style ~|  /Apply || %cancel || Jok |

- |

4. In the new panel, change the Value to 1anduse and the Color ramp to Random colors

5. Click the button labeled Classify

Layer Properties - landuse | Symbology
| = categorized ]

%) Information Value abc landuse -] |E|

:-'C\ Source symbol | 'I‘:'|
Color ramp | Random colors |'|
Q’ Ssymbology =
Symbol = Value Legend
€3 Labels v [l cemetery cemetery
v/ [ conservation conservation
D Masks v/ [l farmland farmland
v/ [l forest forest
IELTE v/ [ grass grass
v Il industrial industrial
ﬁ 3D View v/l orchard orchard
v/ [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l village _green village green
Form v [ vineyard vineyard
v [ all other values
Joins
=~ Auxiliary
© 7 Storage | Classify || 4 || = DeleteAll | |Advanced - |

@ Actions
- Display

» Layer Rendering
@Help || sStyle - _ /Apply || % cancel |[ < oK l

- |

6. Klicken Sie auf OK

You'll see something like this:
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7. Click the arrow (or plus sign) next to 1anduse in the Layers panel, you'll see the categories explained:
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Layers (&) )
o [ ® T &~5 & [
» v o places -
v| ] buildings
v — roads
water [
v rivers
* W .~ landuse
v . cemetery
. conservation

B farmland

. Forest

I grass
B industrial

I orchard
. reservoir

B residential

I village_green
"] vineyard

e e e e e e L

Now our landuse polygons are colored and are classified so that areas with the same land use are the same
color.

8. If you wish to, you can change the symbol of each landuse area by double-clicking the relevant color block in
the Layers panel or in the Layer Properties dialog:
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Symbol Selector

(%]
Unit | Millimeters - |
Opacity ~1/100,0 % |:_|
Color | H
| ©. Favorites a|~| &
| Z/ BN

gradient gray 3 fill hashed black/  hashed black,

plasma
|| B |save Symbol... | | Advanced ~|
| @Help | | % cancel H « oK ]

Notice that there is one category that’s empty:
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Layer Properties - landuse | Symbology B

Q = Categorized -

@ information Value a< landuse ~|[g

Symbol [ ] |+

‘:{:\‘_- Source

& symbology

Color ramp Random colors M

symbol = Value Legend
€3 Labels v [ cemetery cemetery
v/ [l conservation conservation
EED Masks v/ [l farmland farmland
. v/ [l forest forest
, Diagrams v/ [ grass grass
v Il industrial industrial
ﬁ 3D View v [l orchard orchard
v [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l v?llage_green v?llage_green
v [ vineyard vineyard

Form
all other values

<
|

Joins

L Auxiliary
< B storage

{;'.-® Actions

@ Display —| @Help Style - « Apply || % cancel

Classify | = | = | Delete All Advanced ~
P Layer Rendering

This empty category is used to color any objects which do not have a landuse value defined or which have a NULL
value. It can be useful to keep this empty category so that areas with a NULL value are still represented on the map.
You may like to change the color to more obviously represent a blank or NULL value.

Remember to save your map now so that you don’t lose all your hard-earned changes!

3.3.2 \ Try Yourself More Classification

Use the knowledge you gained above to classify the bui 1dings layer. Set the categorisation against the building
field and use the Spectral color ramp.

Bemerkung: Remember to zoom into an urban area to see the results.

3.3.3 / Follow Along: Ratio Classification

There are four types of classification: nominal, ordinal, interval and ratio.

In nominal classification, the categories that objects are classified into are name-based; they have no order. For
example: town names, district codes, etc. Symbols that are used for nominal data should not imply any order or
magnitude.

* For points, we can use symbols of different shape.
* For polygons, we can use different types of hatching or different colours (avoid mixing light and dark colours).

* For lines, we can use different dash patterns, different colours (avoid mixing light and dark colours) and
different symbols along the lines.
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In ordinal classification, the categories are arranged in a certain order. For example, world cities are given a rank
depending on their importance for world trade, travel, culture, etc. Symbols that are used for ordinal data should
imply order, but not magnitude.

* For points, we can use symbols with light to dark colours.
* For polygons, we can use graduated colours (light to dark).
* For lines, we can use graduated colours (light to dark).

In interval classification, the numbers are on a scale with positive, negative and zero values. For example: height
above/below sea level, temperature in degrees Celsius. Symbols that are used for interval data should imply order and
magnitude.

* For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
¢ For lines, we can use thickness (thin to thick).

In ratio classification, the numbers are on a scale with only positive and zero values. For example: temperature above
absolute zero (0 degrees Kelvin), distance from a point, the average amount of traffic on a given street per month,
etc. Symbols that are used for ratio data should imply order and magnitude.

* For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
¢ For lines, we can use thickness (thin to thick).

In the example above, we used nominal classification to color each record in the landuse layer based on its
landuse attribute. Now we will use ratio classification to classify the records by area.

We are going to reclassify the layer, so existing classes will be lost if not saved. To store the current classification:
1. Open the layer’s properties dialog
2. Click the Save Style ... button in the Style drop-down menu.
3. Select Rename Current..., enter land usage and press OK.
The categories and their symbols are now saved in the layer’s properties.

4. Click now on the Add... entry of the Style drop-down menu and create a new style named rat io. This will
store the new classification.

5. Close the Layer Properties dialog

We want to classify the landuse areas by size, but there is a problem: they don’t have a size field, so we’ll have to
make one.

1. Open the Attributes Table for the 1anduse layer.
2. Enter edit mode by clicking the & Toegle editing pyiron

3. Add a new column of decimal type, called AREA, using the 2 New e button:

Add Field Lo

Name AREA
Comment
Type Decimal number (double) -

Provider type FLOAT
 Cancel | /0K
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4. Klicken Sie auf OK

The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However,

at the moment it is not populated, it just has a lot of NULL values.

To solve this problem, we will need to calculate the areas.

1. Open the field calculator with the 2% button.

You will get this dialog:
(=) landuse — Field Calculater 4
Only update 0 selected features
v | Create a new field Update existing field
Create virtual field
Output field name
Cutput field type | Binary object (BLOB) -
Cutput field length | 0 Precision 3
Expression Function Editor
s || nke L Se.. Show Help
row_number
F Aggregates
b Arrays
» Color
b Conditionals
k Conversions
» Date and Time
+ Fields and Yalues
b Files and Paths
¥ Fuzzy Matching
b General
F Geometry
b Map Layers
» Maps
F Math
b Operators
- » Rasters
=+ ILCJ [ ¥ Record and Attribu...
k String
TEos - b b User expressions
Preview: » Variables
OK Help
2. Check the A Update existing fields
3. Select AREA in the fields drop-down menu
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Field Calculator %

Create a new field v Update existing Field

1.2 AREA -

4. Under the Expression tab, expand the Geometry functions group in the list and find $area

5. Double-click on it so that it appears in the Expression field

landuse — Field Calculator o

Create a new Field v Update existing Field
1.2 AREA -

Expression | Function Editor

8 &L A Search... function $area
sares r E=o . ~ Returns the area of the current feature. The
» Date and Time . :
» Fields and Values area calculated by this function respects both
» Files and Paths the current project's ellipsoid setting and area
» Fuzzy Matching unit settings. For example, if an ellipsoid has
» General been set for the project then the calculated
~ Geomekry area will be ellipsoidal, and if no ellipsoid is
anﬂle at_vertex set then the calculated area will be
planimetric.
area
azimuth Syntax
boundary .
bounds area
=LA A A ) bounds_height
bounds_width Examples
Feature |1 - 3 buffer
Preview: 1312821.1395745648 buffer_by_m - * $area 42

@Help ¥ cancel «/ OK

6. Klicken Sie auf OK

7. Scroll to the AREA field in the attribute table and you will notice that it is populated with values (you
may need to click the column header to refresh the data).

Bemerkung: These areas respect the project’s area unit settings, so they may be in square meters or square
degrees.

5. Press B to save the edits and exit the edit mode with ,ﬁ; Toggle editing
6. Close the attribute table
Now that we have the data, let’s use them to render the 1anduse layer.
1. Open the Layer properties dialog’s Symbology tab for the 1anduse layer

2. Change the classification style from Categorized to Graduated
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3. Change the Value to AREA

4. Under Color ramp, choose the option Create New Color Ramp...:

@ Layer Properties - landuse | Symbology

Q

" Symbology

X
| = Graduated -
[ |12 agea ") |E|
Symbol | |:|

Legend format |%1— Yol

||Precim'or14 |3| V| Trim

I

Color ramp |
Labels T
& | Classes | ] Invert Coler Ramp
i Random Ceolor Ramp
Masks Symbol ~ V
] I Blues
Diagrams I Greens
Fields M Greys
. Magma
Attributes Form I I RdGy
I Reds
Joins
I |Spectra|
iary Storage . Viridis
All Color Ramps b
Actio
Create Mew Celor Ramp...
Display Edit Color Ramp...
— Save Color Ramp..,
Rendering Made | §iE Equarcommyguanmey——1 Classes | 5 =
e | Classify | |i| |E| | Delete Al | | Advanced '|
V| Link dass boundaries
Variables
b Layer Rendering
Mstadata [ sy - ok || cancd || mply || Hep |
5. Choose Gradient (if it’s not selected already) and click OK. You will see this:
87
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() Select Color Ramp >

Color 1 | (N |~ color 2 | IR |~/ Type | Continuous B

] ]
w Gradient Stop -
Relative position | 0.0 %G Delete Stop
5 * .
m|® Z o B N o :
Standard colors * | = 100%  |w

100% |«

255 =

L ~| | Opadty S v -

o | = HTML notation | 0000

Current

w Flot

Information oK Cancel Help

You'll be using this to denote area, with small areas as Color 1 and large areas as Color 2.
6. Choose appropriate colors

In the example, the result looks like this:
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(&) Select Color Ramp >

Color 1 - Color 2 _ - Type | Continuous =
| I |~ | O | o | |

w Gradient Stop |~

Relative position | 0.0 % = | Delete Stop

CREERE-REA Ow RV v [}

Standird colors “H | Os Y O e -
—‘ - -

. o I o

1
[ | - | Opadty T lw00% |2

|£"E| HTML notation | #h2dfaa v |

ot o eI
Y OO ]

Information oK ] | Cancel | | Help

7. Klicken Sie auf OK

8. You can save the colour ramp by selecting Save Color Ramp... under the Color ramp tab. Choose an appropriate
name for the colour ramp and click Save. You will now be able to select the same colour ramp easily under All
Color Ramps.

9. Click Classify

Now you will have something like this:
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@ Layer Properties - landuse | Symbelogy x
Q = Graduated - |
Value |1-2 AREA - | | £ |
Symboal | |'|
Legend format |%1— %2 | |Precision 0 |$| V| Trim
‘ Symbology _———  __
Colorramp | ~TTNINSS—S—S————————
abe! ————
| Classes | Histogram
e Symbol ™ Values Legend
¥ 131.30 - 10512.65 131-10313
¥ . 10512.65 - 35728.06 10513 - 35728
= v . 35728.06 - 132271.73 35728 - 132272
= ¥ . 132271.73 - 362220.57 132272 - 362221
- ¥ . 362220.57 - 112894046.06 362221 - 112894046
=0
Mode | H:EHEquaI Count (Quantile) ~ | Classes | 5 3|
| Classify | |¥| |;| | Delete Al | | Advanced '|
V| Link class boundaries
O

B Layer Rendering

| stye - ok || cancel || Appy || hHep |

Leave everything else as-is.

10. Click OK:

Bontebok &¥Shop)
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3.34 / Try Yourself Refine the Classification

* Change the values of Mode and Classes until you get a classification that makes sense.

Check your results

3.3.5 ﬂ'—- Follow Along: Rule-based Classification

It’s often useful to combine multiple criteria for a classification, but unfortunately normal classification only takes
one attribute into account. That’s where rule-based classification comes in handy.

In this lesson, we will represent the 1anduse layer in a way to easily identify Swellendam city from the other
residential area, and from the other types of landuse (based on their area).

1. Open the Layer Properties dialog for the 1anduse layer
2. Switch to the Symbology tab
3. Switch the classification style to Rule-based

QGIS will automatically show the rules that represent the current classification implemented for this layer. For
example, after completing the exercise above, you may see something like this:

@ Layer Properties - landuse | Symbology *
: [= Rule-based A
Information Label Rule Min, scale Max.
v 131 - 101924 "AREA" »= 131.290349 AND "AREA" <= 101924.493748
%‘s\ Trrmrr v 101324 - 300418 "AREA" » 101924,409743 AND "AREA" <= 300417.846208
. v 309418 - 839955 "AREA" » 309417.246808 AND "AREA" <= 833934777308
# Symbology v . 839955 - 1578789 "AREA" » 839854.777508 AND "AREA" <= 1578788.863263
v . 1578789 - 34452227 "AREA" » 1378788.863263 AND "AREA" <= 34452226.558486
€ Labels v . 34452227 - 112894046 "AREA" » 34457225,958486 AND "AREA" <= 112894046.060455
m Masks
Diagrams 7 §
E Fields E.'E':‘ A H Symbol Levels. ..
: Refine Selected Rules
E Attributes Form

p Layer Rendering

Joins Style - oK Cancel Apply Help

4. Click and drag to select all the rules

5. Use the "= Remowe sclected rules hyton o remove all of the existing rules
Let’s now add our custom rules.

1. Click the Ell'l}:l Addrule tyytton

2. The Edit rule dialog then appears

3. Enter Swellendam city as Label

4. Click the € button next to the Filter text area to open the Expression String Builder

5. Enter the criterion "name" = 'Swellendam' and validate
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Expression String Builder B3

Expression | Function Editor

=] oL ke Q search... group field =
- ‘Swellendam' iti -
vekhendan ' Condlthnals Double-click to add field name to expression string.
» Conversions . .
} Custom Right-Click on field name to open context menu sample value
» Date and Time loading options.
~ Fields and Values Notes
NULL s .
123 ogc_fid
ae full_id Values | @ search...
abc psm_id
abc osm_type All Unigue 10 Samples
=< landuse Fynbos Heights -
T | caikouLodge
ahc bype Koloniesbos
- ane wikipedia Koornland
= A AU ave boundary Marloth Nature Reserve
ab< js in Railton
Feature 1 - > abe lefsure swellendam
Preview: 0 abc name:de - |Wamakersbos -

@Help * Cancel

6. Back to the Edit rule dalog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border

Label swellendam city =
e Filter "name" = 'Swellendam’ £ Test
Else Cakch-all for other features
Description
Scale range
v! Symbol
&
B simple Fill
Unit Millimeters -
Opacity _11100.0 % -
Color [

-

@Help # cancel

7. Press OK
8. Repeat the steps above to add the following rules:

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam' (or "landuse" = 'residential' AND "name" != 'Swellendam').
Choose a pale blue-grey Fill color

2. Bignon residential areas label with the criterion "1anduse" <> 'residential' AND "AREA"
>= 605000. Choose a mid-green color.
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Layer Properties — landuse (basic) — Symbology B
= Rule-based

fz' Information Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’
a\:\\ Source v Other residenttial "landuse” = 'residential' AND "name" <> 'Swellendam'

v| [l Big non residential areas "landuse” <> 'residential’ AND "AREA" >= 605000
d’ Ssymbology

W# 30 View

-
4 Diagrams

Ea 7| Z
E Fields

E Attributes Form

Symbol Levels...

» Layer Rendering
Joins @Help Style -

«/Apply | % cCancel

These filters are exclusive, in that they exclude areas on the map (non-residential areas which are smaller
than 605000 (square meters) are not included in any of the rules).

3. We will catch the remaining features using a new rule labeled Small non residential areas. Instead of a

filter expression, Check the ® | Else. Give this category a suitable pale green color.

Label small non residential areas =
Filter
® Else Catch-all for other features

Description

Scale range

v| Ssymbol

o
simple Fill

Unit Millimeters

Opacity _11100.0 %
Color

-

@Help *® cancel

Your rules should now look like this:
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Layer Properties — landuse (basic) — Symbology

S [ErRulebased

2 Information Label

"\;\ Source || other residenttial

" Ssymbology

[abc JELS

# 3D View

Diagrams

i Fields l_i_l

E Attributes Form

P Layer Rendering

Joins _| @relp || style -|

9. Apply this symbology

Your map will look something like this:

Qm&_

Rule Min. Scale Max. Scale Count Duplicate Count
M swellendam city "name" = 'Swellendam’
"landuse" = 'residential' AND "name" <> 'Swellendam’
M Big non residential areas "landuse” <> 'residential’ AND "AREA" >= 605000
small non residential areas ELSE
[Zl[z] |symbol Levels...|

| /Apply || %cancel H +/ oK I

Now you have a map with Swellendam the most prominent residential area and other non-residential areas colored

according to their size.

94
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3.3.6 In Conclusion
Symbology allows us to represent the attributes of a layer in an easy-to-read way. It allows us as well as the map reader

to understand the significance of features, using any relevant attributes that we choose. Depending on the problems
you face, you’ll apply different classification techniques to solve them.

3.3.7 What’s Next?

Now we have a nice-looking map, but how are we going to get it out of QGIS and into a format we can print out, or
make into an image or PDF? That’s the topic of the next lesson!
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KAPITEL 4

Module: Layout der Karten

In diesem Modul lernen Sie, wie Sie das QGIS-Drucklayout verwenden, um qualitativ hochwertige Karten mit allen
erforderlichen Kartenkomponenten zu erstellen.

4.1 Lesson: Using Print Layout

Now that you’ve got a map, you need to be able to print it or to export it to a document. The reason is, a GIS map
file is not an image. Rather, it saves the state of the GIS program, with references to all the layers, their labels,colors,
etc. So for someone who doesn’t have the data or the same GIS program (such as QGIS), the map file will be useless.
Luckily, QGIS can export its map file to a format that anyone’s computer can read, as well as printing out the map if
you have a printer connected. Both exporting and printing is handled via the Print Layout.

The goal for this lesson: To use the QGIS Print Layout to create a basic map with all the required settings.

411 \ Follow Along: The Layout Manager

QGIS allows you to create multiple maps using the same map file. For this reason, it has a tool called the Layout
Manager.

1. Click on the Project » Layout Manager... menu entry to open this tool. You'll see a blank Layout manager
dialog appear.
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Layout Manager B3

w New from Template

Empty layout -

Open template directory User

@Help % Close

2. Under New from Template, select Empty layout and press the Create... button.

3. Give the new layout the name of Swellendam and click OK.

4. You will now see the Print Layout window:

Swellendam

Layout Edit View [tems AddItem Atlas Settings

e TV NLY

0

50

150

200|

«Pd FEAODHFEZOE

|o |50 |100 |150| |200 |250 ‘300 ltems BE®
ol b b b b b bbb booon b bveon vl —
2 - Iltem

Layout | Item Properties | Guides

Item Properties (=]ES]
Page Size
Size A4 K ER
Orientation Landscape K="
Width 297,000 3 &
Height 210,000 =K ES

Exclude page from exports =,

Background v

x: 169.559 mm y: 86.6092 mm page: 1 43.4% v |

You could also create this new layout via the Project » New Print Layout... menu.

Whichever route you take, the new print layout is now accessible from the Project » Layouts » menu, as in the image

below.
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Edit View Layer Settings Plugins Vector Raster Databa

" New Ctrl+N ;] gju g} &q

New from Template ’
Qpen... ctrl+o
Open From b
Open Recent »
Close
= save ctrl+s
| Save As... Ctrl+Shift+s
save To »
Revert...
Properties... Ctrli+Shift+P
Snapping Options...
Import/Export »
i New Print Layout... ctrl+P

2} New Report...

% Layout Manager...

Swellendam
Exit QGIS crl+Q

41.2 \ Follow Along: Basic Map Composition

In this example, the composition was already the way we wanted it. Ensure that yours is as well.

1. Right-click on the sheet in the central part of the layout window and choose Page properties... in the context
menu.

2. Check that the values in the Item Properties tab are set to the following:
* Size: A4
* Orientation: Landscape

Now you’ve got the page layout the way you wanted it, but this page is still blank. It clearly lacks a map. Let’s
fix that!

3. Click on the L £ A%Map bygion,
With this tool activated, you will be able to place a map on the page.

4. Click and drag a box on the blank page:
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*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRLURORE B @ikt e | | BE H- @

|o |50 |1on |150 |2ﬂn |250 | ‘300 ltems E®
v bbb b bvraoa b bvooo v bvvoar b bl vrah g —
@ 3 = & Item
el
ﬁ 3
5 EE Layout = Item Properties = Guides
!f;’ = Item Properties =]
8| :
L2
E
) .
E_
. |23
=._n ]
= ]
he <
3
width: 289.104 mm height: 202.495 mm X:292.763 mm y: 206.154 mm page: 1 43.4% v [

The map will appear on the page.
5. Move the map by clicking and dragging it around:

*Swellendam

Layout Edit View [tems AddIitem Atlas Settings

BRLRDR oy e | | B® H- B

300 Jtems
@ & Itern

|0 |50 |100 ||150 |200 |250
s oo b b oo b b oo boode b rcoac oo b ocoa v boroa vl

Aol &

Layout | Item Properties | Guides

I’;’ = Item Properties @®
2} = Map 1

— SERER MR =
IFYEE :
= 3 ¥ Main Properties [
| = Scale 38108 | &

E - -
i-'u = Map rotation 0,00° |v| LET
= E CRS Use Project CRS - | |§|
A} . v Draw map canvas items

Rz

2 2 ¥ Lavers |~
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6. Resize it by clicking and dragging the boxes on the edges:
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*Swellendam
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Bemerkung: Your map may look a lot different, of course! This depends on how your own project is set up.
But not to worry! These instructions are general, so they will work the same regardless of what the map itself
looks like.

7. Be sure to leave margins along the edges, and a space along the top for the title.

8. Zoom in and out on the page (but not the map!) by using these buttons:
e e
: 3 s : l@ Move item content
9. Zoom and pan the map in the main QGIS window. You can also pan the map using the ove ttem content ¢q0],

The map view updates as you zoom in or zoom out.

10. If, for any reason, the map view does not refresh correctly, you can force the map to refresh by clicking the

E Refresh view button.

Remember that the size and position you’ve given the map doesn’t need to be final. You can always come back
and change it later if you’re not satisfied. For now, you need to ensure that you’ve saved your work on this map.
Because a Print Layout in QGIS is part of the main map file, you must save your project.

=]
11. Go to the Layout » Save Project. This is a convenient shortcut to the one in the main dialog.

413 \

Now your map is looking good on the page, but your readers/users are not being told what’s going on yet. They need
some context, which is what you’ll provide for them by adding map elements. First, let us add a title.

Follow Along: Adding a Title

. T
1. Click on the Add Label 1y, ¢ton

2. Click on the page, above the map, accept the suggested values in the New Item Properties dialog, and a label
will appear at the top of the map.

3. Resize it and place it in the top center of the page. It can be resized and moved in the same way that you resized
and moved the map.
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As you move the title, you'll notice that guidelines appear to help you position the title in the center of the page.

However, there is also a tool in the Actions Toolbar to help position the title relative to the map (not the page):
|IZI
4. Click the map to select it

5. Hold in Shift on your keyboard and click on the label so that both the map and the label are selected.

I .
6. Look for the | Alienseleced tems kft byygton and click on the dropdown arrow next to it to reveal the positioning

options and click |i—| Align center:

QS M » )
|3|ﬂ'? Iltem Align Left
all . Align Center g
| Align Right
~ Align Top

-~ Align Center Vertical

Layi - Align Bottom

Now the label frame is centered on the map, but not the contents. To center the contents of the label:
1. Select the label by clicking on it.
2. Click on the Item Properties tab in the side panel of the layout window.

3. Change the text of the label to ,,Swellendam*:
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Layout | Item Properties | Guides

Itemn Properties @
Label

¥ Main Properties

Sswellendam

Render as HTML

Insert an Expression...

v Appearance

Font r
Font color I (-
Horizontal margin | 0.00 mm =
Vertical margin 0.00 mm =

Horizontal alignment

Left Center Right (e Justify
Vertical alignment
e Top Middle Bottom

Position and Size

>

P Rotation

3 Frame

3 Background
P Item ID

4. Use this interface to set the font and alignment options under the Appearance section:
1. Choose a large but sensible font (the example will use the default font with a size of 36)
2. Set the Horizontal Alignment to Center.
You can also change the font color, but it’s probably best to keep it black as per the default.

5. The default setting is not to add a frame to the title’s text box. However, if you wish to add a frame, you
can do so:

1. In the Item Properties tab, scroll down until you see the Frame option.
2. Click the Frame checkbox to enable the frame. You can also change the frame’s color and width.

In this example, we won’t enable the frame, so here is our page so far:

41.
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*Swellendam
Layout Edit View [tems AddItem Atlas Settings
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!f? = Item Properties (E=]ES
g -
IPYEE
=
=.__n '—:
E
e
X:173.218 mm y: -4.26947 mm page: 1 |43.4% n | (———

To make sure that you don’t accidentally move these elements around now that you’ve aligned them, you can
lock items into place:

1. Select both the label and the map items

Fii
2. Click the % Lock Selected Items 1yy¢to in the Actions Toolbar.

Bemerkung: Click the [@I Unlock AllTtems by tton in the Actions Toolbar to be able to edit the items again.

41.4 \ Follow Along: Adding a Legend

The map reader also needs to be able to see what various things on the map actually mean. In some cases, like the
place names, this is quite obvious. In other cases, it’s more difficult to guess, like the colors of the forests. Let’s add
a new legend.

1. Click on the &g Add Lezend pyion

2. Click on the page to place the legend, accept the suggested values in the New Item Properties dialog,

3. Alegend is added to the layout page, showing layers symbology as set in the main dialog.

4. As usual, you can click and move the item to where you want it:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings

BRORER R eRREe ¢ B© 00 QR bbb > ®P -

v Resize to fit contents

|o |50 |1on |150 |2ﬂn | ‘250 ‘300 ltems =5
v bbb b boraoa b bvooo v brvoao b bl vl —
'{rj 1 @ 8 ltem
p = | | Legend
é 3 Swellendam v Swellendam
o 3 end
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| 2
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415 / Follow Along: Customizing Legend Items

Not everything on the legend is necessary, so let’s remove some unwanted items.

1. In the Item Properties tab, you’ll find the Legend items group.

2. Uncheck the L) Auto update box, allowing you to directly modify the legend items
3. Select the entry with buildings

4. Delete it from the legend by clicking the = button
You can also rename items.

1. Select a layer from the same list.

2. Click the @ Edit selected item properties button.
3. Rename the layers to Places, Roads and Streets, Surface Water, and Rivers.

You can also reorder the items:
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*Swellendam
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As the legend will likely be widened by the new layer names, you may wish to move and resize the legend and or map.
This is the result:

*Swellendam

Layout Edit View |[tems AddItem Atlas Settings
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4.1.6 \ Follow Along: Exporting Your Map

Bemerkung: Did you remember to save your work often?

Finally the map is ready for export! You’'ll see the export buttons near the top left corner of the layout window:

o B PrincLayout, jnterfaces with a printer. Since the printer options will differ depending on the model of printer
that you're working with, it’s probably better to consult the printer manual or a general guide to printing for

more information on this topic.

The other buttons allow you to export the map page to a file.

o g Brportas Tmage, gives you a selection of various common image formats to choose from. This is probably the

simplest option, but the image it creates is ,,dead* and difficult to edit.

. Exportas SVG: If you're sending the map to a cartographer (who may want to edit the map for publication),
it’s best to export as an SVG. SVG stands for ,,Scalable Vector Graphic®, and can be imported to programs like

Inkscape or other vector image editing software.

> S, - .
o 1/ Exportas PDF: If you need to send the map to a client, it’s most common to use a PDF, because it’s easier to
set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a program that

allows them to import and edit this format.

For our purposes, we’re going to use PDF.

1. Click the "L Exportas PDF 1y3¢ton

2. Choose a save location and a file name as usual. The following dialog will show up.

4.1. Lesson: Using Print Layout
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PDF Export Options 0

lw| Export Options

Always export as vectors
v Append georeference information
v Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) -

v Advanced Options

Disable tiled raster layer exports

v Simplify geometries to reduce output File size

@Help % cancel | Psave |

3. You can safely use the default values now and click Save.
QGIS will proceed to the map export and push a message on top of the print layout dialog as soon as it finishes.

4. Click the hyperlink in the message to open the folder in which the PDF has been saved in your system’s file
manager

5. Open it and see how your layout looks.
Everything is OK? Congratulations on your first completed QGIS map project!
6. Anything unsatisfying? Go back to the QGIS window, do the appropriate modifications and export again.

7. Remember to save your project file.
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4.1.7 In Conclusion

Now you know how to create a basic static map layout. We can go a step further and create a map layout that adapts
dynamically, with more layout items.

4.2 Lesson: Creating a Dynamic Print Layout

Now that you have learned to create a basic map layout we go a step further and create a map layout that adapts
dynamically to our map extent and to the page properties, e.g. when you change the size of the page. Also, the date
of creation will adapt dynamically.

4.2.1 / Follow Along: Creating the dynamic map canvas

1. Load the ESRI Shapefile format datasets protected_areas.shp, places.shp, rivers.shp and
water . shp into the map canvas and adapt its properties to suit your own convenience.

2. After everything is rendered and symbolized to your liking, click the h New Print Layout jeon ip the toolbar or
choose File » New Print Layout. You will be prompted to choose a title for the new print layout.

3. We want to create a map layout consisting of a header and a map of the region near Swellendam, South Africa.
The layout should have a margin of 7.5 mm and the header should be 36mm high.

4. Create a map item called main map on the canvas and go to the Layout panel. Scroll down to the Variables
section and find the Layout part. Here we set some variables you can use all over the dynamic print layout. Go
to the Layout panel and scroll down to the Variables section. The first variable will define the margin. Press

the '37':'-!] button and type in the name sw_layout_margin. Set the value to 7. 5. Press the I:II'II-I:| button again
and type in the name sw_layout_height_header. Set the value to 36.

5. Now you are ready to create the position and the size of the map canvas automatically by means of the
variables. Make sure that your map item is selected, go to the Irem Properties panel, scroll down to and

open the Position and Size section. Click the 4E] Data defined overrde o ¥ and from the Variables entry, choose
@sw_layout_margin.

6. Click the 4&| Data defined override g1y choose Edit... and type in the formula:

’to_real(@sw_layout_margin) + to_real (@sw_layout_height_header)

7. You can create the size of the map item by using the variables for Width and Height. Click the €
Data defined override for Width and choose Edit ... again. Fill in the formula:

’@layout_pagewidth - @sw_layout_margin * 2

Click the 46| Data defined override Height and choose Edit .... Here fill in the formula:

’@layout_pageheight — (@sw_layout_height_header - (@sw_layout_margin * 2

8. We will also create a grid containing the coordinates of the main canvas map extent. Go to Item Properties

again and choose the Grids section. Insert a grid by clicking the I:II-I:I-I:I button. Click on Modify grid ... and set
the Interval for X, Y and Offset according to the map scale you chose in the QGIS main canvas. The Grid type
Cross is very well suited for our purposes.
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4.2.2 / Follow Along: Creating the dynamic header

1. Insert a rectangle which will contain the header with the (3 Add Shape

header.

button. In the Items panel enter the name

2. Again, go to the Item Properties and open the Position and Size section. Using 4E] pata definea override  choose the
sw_layout_margin variable for X as well as for Y. Width shall be defined by the expression:

@layout_pagewidth - @sw_layout_margin * 2

and Height by the sw_layout_height_header variable.

3. We will insert a horizontal line and two vertical lines to divide the header into different sections using the IE
Add Node Item ' (“reate a horizontal line and two vertical lines and name them Horizontal line,Vertical
line 1Vertical line 2.

1. For the horizontal line:
1. Set X to the variable sw_layout_margin

2. Set the expression for Y to:

’@sw_layout_margin + 8

3. Set the expression for Width to:

’@layout_pagewidth - (@sw_layout_margin * 3 - 53.5

2. For the first vertical line:

1. Set the expression for X to:

’@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Set Y to the variable sw_layout_margin

3. The height must be the same as the header we created, so set Height to the variable
sw_layout_height_header.

3. The second vertical line is placed to the left of the first one.

1. Set the expression for X to:

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. Set Y to the variable sw_layout_margin

3. The height shall be the same as the other vertical line, so set Height to the variable
sw_layout_height_header.

The figure below shows the structure of our dynamic layout. We will fill the areas created by the lines with
some elements.
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4.2.3 / Follow Along: Creating labels for the dynamic header

1. The title of your QGIS project can be included automatically. The title is set in the Project Properties. Insert

a label with the @! AddLabel bytton and enter the name project title (variable). In the Main
Properties of the Items Properties Panel enter the expression:

[$@project_title%]

Set the position of the label.

1. For X, use the expression:

@sw_layout_margin + 3

2. For Y, use the expression:

@sw_layout_margin + 0.25

3. For Width, use the expression:

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Enter 11.25 for Height
Under Appearance set the Font size to 16 pt.

2. The second label will include a description of the map you created. Again, insert a label and name it map
description. In the Main Properties enter the text map description. In the Main Properties we will
also include:

printed on: [%$format_date (now (), 'dd.MM.yyyy')%]

Here we used two Date and Time functions (now and format_date).
Set the position of the label.

1. For X, use the expression:
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’@sw_layout_margin + 3

2. For Y, use the expression:

’@sw_layout_margin + 11.5

3. The third label will include information about your organisation. First we will create some variables in the

Variables menu of the Item Properties. Go to the Layout menu, click the I:II-I:I-I:I button each time and enter the
names o_department, o_name, o_adress and o_postcode. In the second row enter the information
about your organisation. We will use these variables in the Main Properties section.

In Main Properties enter:

o)

@o_name %]
@o_department %]
@o_adress %]
Qo_postcode %]

o° o° o o

Set the position of the label.

1. For X, use the expression:

’@layout_pagewidth - @sw_layout_margin - 49.5

2. For Y, use the expression:

’@sw_layout_margin + 15.5

3. For Width, use 49.00

4. For Height, use the expression:

’@sw_layout_height_header - 15.5
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Layout @ Item Properties = Guides = Atlas

Item Properties (3]
Label

¥ Main Properties

[% @o_name%]

[% @0 department]
[% @o_adress%]

Pﬁ @o_postcode%|

Render as HTML

Insert an EKPFEESiGI"I...

4.2.4 / Follow Along: Adding pictures to the dynamic header

1. Use the " AddPicwre byton to place a picture above your label organisation information. After
entering the name organisation logo define the position and size of the logo:

1. For X, use the expression:

’@layout_pagewidth - @sw_layout_margin - 49.5

2. For Y, use the expression:

’@sw_layout_margin + 3.5

3. For Width, use 39.292
4. For Height, use 9.583
To include a logo of your organisation you have to save your logo under your home directory and enter the path
under Main Properties » Image Source.
2. Our layout still needs a north arrow. This will also be inserted by using A] Add North Arrow e wil] use the
default north arrow. Define the position:

1. For X, use the expression:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:
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@sw_layout_margin + 9

3. For Width,use 21.027
4. For Height,use 21.157

4.2.5 / Follow Along: Creating the scalebar of the dynamic header

1. To insert a scalebar in the header click on & AddSeale Bar apnd place it in the rectangle above the north arrow.

In Map under the Main Properties choose your main map (Map 1). This means that the scale changes
automatically according to the extent you choose in the QGIS main canvas. Choose the Style Numeric. This
means that we insert a simple scale without a scalebar. The scale still needs a position and size.

1. For X, use the expression:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:

@sw_layout_margin + 1

3. For Width, use 25
4. For Height, use 8
5. Place the Reference point in the center.

Congratulations! You have created your first dynamic map layout. Take a look at the layout and check if everything
looks the way you want it! The dynamic map layout reacts automatically when you change the page properties. For

| .
example, if you change the page size from DIN A4 to DIN A3, click the Fw Refresh view bytton and the page design is
adapted.
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4.2.6 What’s Next?

On the next page, you will be given an assignment to complete. This will allow you to practice the techniques you
have learned so far.

4.3 Zuordnung 1

Open your existing map project and revise it thoroughly. If you have noticed small errors or things you’d have liked
to fix earlier, do so now.

While customizing your map, keep asking yourself questions. Is this map easy to read and understand for someone
who’s unfamiliar with the data? If I saw this map on the Internet, or on a poster, or in a magazine, would it capture
my attention? Would I want to read this map if it wasn’t mine?

If you're doing this course at a \ Basic or / Intermediate level, read up on techniques from the
more advanced sections. If you see something you'd like to do in your map, why not try to implement it?

If this course is being presented to you, the course presenter may require you to submit a final version of your map,
exported to PDF, for evaluation. If you're doing this course by yourself, it’s recommended that you evaluate your own
map using the same criteria. Your map will be evaluated on the overall appearance and symbology of the map itself,
as well as the appearance and layout of the map page and elements. Remember that the emphasis for evaluating the
appearance of maps will always be ease of use. The nicer the map is to look at and the easier it is to understand at a
glance, the better.

Happy customizing!

4.3.1 In Conclusion

The first four modules have taught you how to create and style a vector map. In the next four modules, you'll learn
how to use QGIS for a complete GIS analysis. This will include creating and editing vector data; analyzing vector
data; using and analyzing raster data; and using GIS to solve a problem from start to finish, using both raster and
vector data sources.
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KAPITEL D

Module: Vektordaten erzeugen

Die Erstellung von Karten unter Verwendung vorhandener Daten ist nur der Anfang. In diesem Modul lernen Sie,
wie Sie bestehende Vektordaten modifizieren und vollstindig neue Datensitze erstellen konnen.

5.1 Lesson: Creating a New Vector Dataset

The data that you use has to come from somewhere. For most common applications, the data exists already; but the
more particular and specialized the project, the less likely it is that the data will already be available. In such cases,
you’ll need to create your own new data.

The goal for this lesson: To create a new vector dataset.

5.1.1 \ Follow Along: The Layer Creation Dialog

Before you can add new vector data, you need a vector dataset to add it to. In our case, you’ll begin by creating new
data entirely, rather than editing an existing dataset. Therefore, you’ll need to define your own new dataset first.

1. Open QGIS and create a new blank project.

2. Navigate to and click on the menu entry Layer » Create Layer » New Shapefile Layer. You'll be presented
with the New Shapefile Layer dialog, which will allow you to define a new layer.
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.
File name
File encoding UTF-8 >
Geometry type Point v
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

Remowve Field

OK Cancel Help

Click ... for the File name field. A save dialog will appear.
Navigate to the exercise_data directory.
Save your new layer as school_property.shp.

It’s important to decide which kind of dataset you want at this stage. Each different vector layer type is ,,built
differently” in the background, so once you've created the layer, you can’t change its type.

For the next exercise, we're going to create new features which describe areas. For such features, you'll need
to create a polygon dataset.

For Geometry Type, select Polygon from the drop down menu:

Geometry type ~ Polygon -

This has no impact on the rest of the dialog, but it will cause the correct type of geometry to be used when the
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vector dataset is created.

The next field allows you to specify the Coordinate Reference System, or CRS. CRS is a method of associating
numerical coordinates with a position on the surface of the Earth. See the User Manual on Working with
Projections to learn more.

For this example we will use the default CRS associated with this project, which is WGS84.

EP5G:4326 - WG5S 84 - ||

Next there is a collection of fields grouped under New Field. By default, a new layer has only one attribute,
the id field (which you should see in the Fields list) below. However, in order for the data you create to be
useful, you actually need to say something about the features you'll be creating in this new layer. For our current
purposes, it will be enough to add one field called name that will hold Text data and will be limited to
text length of 80 characters.

7. Replicate the setup below, then click the Add to Fields List button:

New Field

MName |name
Type |ab<Text data -
Length 80 Precision

Add to Fields List

8. Check that your dialog now looks like this:
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G
File name aining-Data-2.0\exercise_data\school_property.shp
File encoding UTF-8 >
Geometry type ~ Polygon -
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

name String a0

Remowve Field

OK Cancel Help

9. Klicken Sie auf OK

The new layer should appear in your Layers panel.

5.1.2 \ Follow Along: Datenquellen

When you create new data, it obviously has to be about objects that really exist on the ground. Therefore, you'll need
to get your information from somewhere.

There are many different ways to obtain data about objects. For example, you could use a GPS to capture points in
the real world, then import the data into QGIS afterwards. Or you could survey points using a theodolite, and enter
the coordinates manually to create new features. Or you could use the digitizing process to trace objects from remote
sensing data, such as satellite imagery or aerial photography.

For our example, you’ll be using the digitizing approach. Sample raster datasets are provided, so you’ll need to import
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them as necessary.

1. Click on ﬂ Data Source Manager y¢op

Select :.. Raster on the left side.

2.
3. In the Source panel, click on the ... button:
4. Navigate to exercise_data/raster/.
5. Select the file 3420C_2010_327_RGB_LATLNG.t1if.
6. Click Open to close the dialogue window.
x
B crowser Source type
+ Vector ) )
@) Fle ) Protocol: HTTR(S), cloud, etc.
-"!:_ Mesh Loliis -
, Delimited Text Raster Dataset(s) ercise_data\raster\3420C_2010_327_RGB_LATLNG.tf & .. |
‘% GeoPackage
¥ 4" Spatialite
DB2, DB2
m Virtual Layer
&2 wms/wmTs
L wes
g WES
4 ArcGIS Map Server
; - ArcGIS Feature Server
- GeoMNode
| Cose || Add || Hep |
7. Click Add and Close. An image will load into your map.
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@ *Untitled Project - QGIS - [} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEEREX Lo PPRABLNR @6 -5 55 83 =90
®R@V.awm @ o - =y @ : ® 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.5018,34.0192 |% Scale 1:27241 |~ | @ Mognifier 100%  |*| Rotation [0.0° %/ [v/Render @ EPsGia3zs @

8. If you don’t see an aerial image appear, select the new layer, right click, and choose Zoom fo Layer in the
context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Datab:

DEBRRY QPRI PR
B@V.Aam @ /7 :

Layers &
v [l ® T - O

3420C ?2n1n 227 par 1LATING |
sl '® Zoom to Layer

o2 Show in Overview

Copy Layer
Rename Layer
1 Zoom to Native Resolution (100%)
Stretch Using Current Extent
L] Duplicate Layer
[l Remove Layer...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

9. Click on the ﬁ-) ZoomIn bytton, and zoom to the area highlighted in blue below:

5.1. Lesson: Creating a New Vector Dataset 123



QGIS Training Manual

(@ *Untitled Project - QGIS - O x
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBRRX OBFLPAIPRPALEENR &6 -5 -5-5 Im-9 -
R@V- AR B ) b Sl R 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.4529,-34.0291 |¥ Scale 1:27241 |~ @ Magnifier 100%  |%| Rotation [0.0° *|v/Render @ epsGi36 @

Now you are ready to digitize these three fields:
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Before starting to digitize, let’s move the school_property layer above the aerial image.

1. Select school_property layer in the Layers pane and drag it to the top.

Layers e
o [l ® T &§~3 F 4

v [ school property
v 2 3420C 2010 327 RGB LATLNG

In order to begin digitizing, you’ll need to enter edit mode. GIS software commonly requires this to prevent you from
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accidentally editing or deleting important data. Edit mode is switched on or off individually for each layer.
To enter edit mode for the school_property layer:

1. Click on the school_property layer in the Layers panel to select it.

F/ .
2. Click on the .’/ Toggle Editing [ytton.

If you can’t find this button, check that the Digifizing toolbar is enabled. There should be a check mark next to
the View » Toolbars » Digitizing menu entry.

As soon as you are in edit mode, you'll see that some digitizing tools have become active:

. £ Capture Polygon

o / % Vertex Tool

Other relevant buttons are still inactive, but will become active when we start interacting with our new data.

Notice that the layer school_property in the Layers panel now has the pencil icon, indicating that it is in
edit mode.

e )
3. Click on the L3 Capwre Polyzon bytton to begin digitizing our school fields.

You'll notice that your mouse cursor has become a crosshair. This allows you to more accurately place the
points you’ll be digitizing. Remember that even when you're using the digitizing tool, you can zoom in and
out on your map by rolling the mouse wheel, and you can pan around by holding down the mouse wheel and
dragging around in the map.

The first feature you'll be digitizing is the athletics field:

4. Start digitizing by clicking on a point somewhere along the edge of the field.

5. Place more points by clicking further along the edge, until the shape you're drawing completely covers the
field.
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@ +Untitled Project - QGIS — O b4
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBREY 0 ALHAPD "Q  LEORS &&-NN-8-F;HE -~
BR@V:Z2Rm @ 4/ 8BR - b =g mE R A

Layers e
@l e T &-#H0

v! [ school property
v/ I 3420C_2010_327_RGB_LATLNG

| Q Type to locate (Ctri+K) | i 20.444140,-34.024140 | ¢[1:1308 <| @rfwowe |33 00° |2 VIRender @ epsGiaszs @

6. After placing your last point, right click to finish drawing the polygon. This will finalize the feature and show
you the Attributes dialog.

7. Fill in the values as below:

school_property - Feature Attributes

d 1 a |
name | Athletics Field a |
OK || Cancel |
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8. Click OK, and you have created a new feature!

Q@ *Untitled Project - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

heBRRY 0P2PLPHNPDI A BEORS @€ -Ti--58E -~
B@V.Z2m B 4/ BR%- o e = - @A

Layers
o e Ta-BAO

v [# school property
v! ¥ 3420C_2010_327_RGB_LATLNG

| Q. Type to locate (Ctri+K) | i) 20.447232,-34.023345 | ¥ ¢ 1:1308 v @rlwoe 3]s looe  [f| VIRender @ epsci43s @

9. In the Layers panel select the school_property layer.

10. Right click and choose Open Attribute Table in the context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Ras

NEERREY U 2K
RSV Z @B 47

Layers |
« Ml ® T &~5 & O '
7 school prisa l

v % 3420C 2( + Zoom to Layer

Zoom to Selection
“2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer
L Duplicate Layer
[4 Remove Layer...
8 Open Attribute Table
|;.i" |TDggIe Editing
; Current Edits
Filter...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

In the table you will see the feature you just added. While in edit mode you can update the attributes data by
double click on the cell you want to update.
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id name
1 1| Athletics Field

T show Al Features _

g LT ES D BE P E »

* || Update All || Update Selected

11. Close the attribute table.

12. To save the new feature we just created, click on n' Save Edits ¢t

Remember, if you've made a mistake while digitizing a feature, you can always edit it after you're done creating it. If
you’ve made a mistake, continue digitizing until you're done creating the feature as above. Then:

1. Click on /E;{ Vertex Tool ¢,

2. Hover the mouse over a vertex you want to move and left click on the vertex.

3. Move the mouse to the correct location of the vertex, and left click. This will move the vertex to the new

location.
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The same procedure can be used to move a line segment, but you will need to hover over the midpoint of the
line segment.

If you want to undo a change, you can press the b Undo bytton or Ctr1+2.
4. Remember to save your changes by clicking the -4 Save Edits hyton,

5. When done editing, click the y Toggle Editing ytton to get out of edit mode.
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513 \ Try Yourself Digitizing Polygons

Digitize the school itself and the upper field. Use this image to assist you:

Remember that each new feature needs to have a unique id value!

Bemerkung: When you're done adding features to a layer, remember to save your edits and then exit edit mode.

Bemerkung: You can style the fill, outline and label placement and formatting of the school_property using
techniques learnt in earlier lessons.
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514 / Follow Along: Using Vertex Editor Table

Another way to edit a feature is to manually enter the actual coordinate values for each vertex using the Vertex Editor
table.

1. Make sure you are in edit mode on layer school_property.

2. If not already activated, click on /H;( Vertex Tool ¢t

3. Move the mouse over one of the polygon features you created in the school_property layer and right
click on it. This will select the feature and a Vertex Editor pane will appear.

Wertex Editor (& )
X Y r

0 20.4456 -34.0226 |
oo s |
2204457 -34.0251

3204453 -34.0247

4 20.4450 -34.0250

5/ 20.4441 -34.0241

6 20.4456 -34.0226

Bemerkung: This table contains the coordinates for the vertices of the feature. Notice there are seven vertices
for this feature, but only six are visually identified in the map area. Upon closer inspection, one will notice that
row 0 and 6 have identical coordinates. These are the start and end vertices of the feature geometry, and are
required in order to create a closed polygon feature.

4. Click and drag a box over a vertex, or multiple vertices, of the selected feature.
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)

The selected vertices will change to a color blue and the Vertex Editor table will have the corresponding rows
highlighted, which contain the coordinates of the vertices.
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Q@ “basic_map - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DB mRR @@w@a@ﬂa PP, EBLO
LLAYA NS AN % & < = B - @

Browser (=]
QaTHO
<+ Favorites =

» IV Spatial Bookmarks
’ Project Home
+ [a] Home
v OC\
+ @ GeoPackace
Layers (=]
o @l®To-#FTDL

roads

[#] school_property

¥ 3420C 2010 327 RGB LATLNG

[

Vertex Editor 3]
X ' r

0 20.4456 34,0226

1 20.4469 -34.0238

2 20,4457 -34.0251

-34.0247

-34.0250

-34.0241

| Q. Type tolocate (Ctri+K) | Validi rdi| 20.447353,-34.025117 |9 ¢|1:1521

5. To update a coordinate, double left click on the cell in the table that you want to edit and enter the updated
value. In this example, the x coordinate of row 4 is updated from 20.4450 to 20.4444.
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Vertex Editor ®
X v r
0| 20.4456 -34.0226
1) 20,4469 -34.0238
2| 20.4457 -34,0251
3/ 20.4453 -34.0247
e |
5 20,444 -34.0241
6| 20.4456 -34.0226
Q Type to locate (Ctri+K) Validi rdii| 20.4441

6. After entering the updated value, hit the enter key to apply the change. You will see the vertex move to the
new location in the map window.

7. When done editing, click the f Toggle Editing tyytton to get out of edit mode, and save your edits.

5.1.5 \ Try Yourself Digitizing Lines

We are going to digitize two routes which are not already marked on the roads layer; one is a path, the other is a track.
Our path runs along the southern edge of the suburb of Railton, starting and ending at marked roads:
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Our track is a little further to the south:

138 Kapitel 5. Module: Vektordaten erzeugen



QGIS Training Manual

. If the roads layer is not yet in your map, then add the roads layer from the GeoPackage file
training-data.gpkg included in the exercise_data folder of the training data you downloaded.
You can read Follow Along: Loading vector data from a GeoPackage Database for a how-to.

. Create a new ESRI Shapefile line dataset called routes. shp in the exercise_data directory, with

attributes 1d and type (use the approach above to guide you.)

. Activate edit mode on the routes layer.

. Since you are working with a line feature, click on the 3 AddLine bytton to initiate line digitizing mode.

. One at a time, digitize the path and the track on the routes layer. Try to follow the routes as accurately as

possible, adding additional points along corners or turns.

. Set the type attribute value to path or track.

. Use the Layer Properties dialog to add styling to your routes. Feel free to use different styles for paths and

tracks.

F/ I
. Save your edits and toggle off editing mode by pressing the f/ Toggle Editing 1yytton,
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Check your results

5.1.6 In Conclusion

Now you know how to create features! This course doesn’t cover adding point features, because that’s not really
necessary once you've worked with more complicated features (lines and polygons). It works exactly the same, except
that you only click once where you want the point to be, give it attributes as usual, and then the feature is created.

Knowing how to digitize is important because it’s a very common activity in GIS programs.

5.1.7 What’s Next?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons know where they are
in relation to one another. This is called topology. In the next lesson you’ll see an example of why this can be useful.

5.2 Lesson: Funktionstopologie

Topology is a useful aspect of vector data layers, because it minimizes errors such as overlap or gaps.

For example: if two features share a border, and you edit the border using topology, then you won’t need to edit first
one feature, then another, and carefully line up the borders so that they match. Instead, you can edit their shared
border and both features will change at the same time.

The goal for this lesson: To understand topology using examples.

5.2.1 / Follow Along: Snapping
Snapping makes topological editing easier. This will allow your mouse cursor to snap to other objects while you
digitize. To set snapping options:

1. Navigate to the menu entry Project » Snapping Options....

2. Set up your Snapping options dialog to activate the 1anduse layer with Type vertex and tolerance 12 pixels:

Project Snapping Settings s

« | ‘% Advanced Configuration_ | © Topological Editing Snapping on Intersection

Layer Type Tolerance Units Avoid overlap
® places
[ buildings
— roads
M water
rivers
v landuse vertex 12 pixels v

[Tl protected_areas
1 Filter layers...

3. Make sure that the box in the Avoid overlap column is checked.

4. Leave the dialog.

. Select the landuse layer and enter edit mode ( J )

AN W

. Check (under View » Toolbars) that the Advanced Digitizing toolbar is enabled.
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7. Zoom to this area (enable layers and labels if necessary):

*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DNEEREEY U2 HPDH @03 B
AV o @G e GJRRFRR G-Q R Q- PR &[] X K-
QG -N-5-LEE#@E T LR BYARRARNPS Fe® - @

Layers @6
@ vaeva-wmrn
v/ e places =
\f; v| [ buildings
' v| — roads
] v| [ water
Eg v rivers
Fd landuse 15
2% s g
f Browser (]E)
S GRETTe

fo™
£

» 57 Favorites
» " spatial Bookmarks
» [*¥ Project Home

» [& Home

y [0/

» @ GeoPackage

» / Spatialite

» @ postcis

b B WMS/WMTS

» @B XYZ Tiles

» @& wes

» @ WFS/ OGC API - Features
y &

& ArcGisFeatureServer
¢ GeoNode

b

Q Type to locate (Ctrl+K) Coordinate| 20.4898234.00907 |9 Scale|1:14392 |~ | @ Magnifier 100% 2| Rotation |0,0° % |V Render @ EPSCa32e @

8. Digitize this new (fictional) area:

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

NEERRY NP L4  BEOR

AVAELL N QG RE YPEFRY 5-Q-- - PR e[ X K-
Q& -H-a-LEE#EaLT LB BORRDARPS (F 2D - B
Layers @
o @ ® T -5 @& O
Vo | s I
B mee
EE -
Browser (]E)
ﬁ: O2THO

landuse - Feature Attributes

" Actions

vy v wvwwvow

ogc_fid [999{ a I v

@
& Full id o |

osm_id

v v voww

» 7 Favorites
'D ~ | v " spatial Bookmarks
[*® Project Home
@ N [&] Home
% ()
@ GeoPackage
@ « |+ /# SpatiaLite
@ Postals
VS | P MssqQL
@ pB2
@ WMS/WMTS
@ XYZ Tiles
@ wcs
) WFS [ OGC API - Features
& ows
& ArcGisMapServer
& ArcGisFeatureServer
¢ GeoNode

| & Type to locate (Ctrl+K) Coordinate| 2048231,34.00731 |9 Scale|1:143%2 = | @ Magnifier| 100% 2| Rotation |0,0° % v/ Render @ EPsGa3z6 @
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9. When prompted, give it an OGC_FID of 999, but feel free to leave the other values unchanged.

If you are careful while digitizing, and allow the cursor to snap to the vertices of adjoining areas, you’ll notice
that there won’t be any gaps between your new area and the existing adjacent areas.

10. Note the @ undo and (ED redo tools in the Advanced Digitizing toolbar.

5.2.2 / Follow Along: Correct Topological Features

Topology features can sometimes need to be updated. In our study area, an area has been turned into forest, so the
landuse layer need an update. We will therefore expand and join some forest features in this area:

*example - QGIS B

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

PEBRRY OPSLHNPPH QLB LER
TAVEL S =4 RS RERRE 0-Q 2B G- QR[] X K-
06 -N-8-LEE#Esf]T LB BOARTARPS (£ 2P . @

Layers @@
o @ ® T &> AL
v| ® places
v! [ buildings
v| — roads

v| [ water
v rivers

landuse |+

] »
Browser (]E)
OITHO

» 5.7 Favorites

'ﬂv » " spatial Bookmarks

» [¥ Project Home
@' » [&] Home

@ ol
@ GeoPackage
@ « |+ /# SpatiaLite
@ Postals
V; | P MssqQL
) @ pB2
€0 @ WMS/WMTS
@ XYZ Tiles
@ wcs
) WFS [ OGC API - Features
& ows
& ArcGisMapServer
@ ArcGisFeatureServer
¢ GeoNode

BExCREES o

v v v

v v voww

N

Q Type to locate (Ctrl+K) Coordinate| 20.48982-34.00907 | Scale|1:14392 ~ | @@ Magnifier 100% ~| Rotation |0,0° %) v/ Render @ epsGia32s @

Instead of creating new polygons to join the forest areas, we are going to use the Vertex Tool to edit and join existing
polygons.

1. Enter edit mode (if it is not active already)

2. Select the ﬁ?( Vertex Tool (]

3. Choose an area of forest, select a vertex, and move it to an adjoining vertex so that the two forest features meet:

142 Kapitel 5. Module: Vektordaten erzeugen



QGIS Training Manual

*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
DEERRY OAPLHPRFALEEDR

21718 %2 [&F 09 QRS YERYE G- QB G B
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Eg v rivers
I landuse IS
% It g
f Browser @® |
S navre J

» ¢ Favorites |
'uv » [[* spatial Bookmarks |
» [¥ Project Home

b &) Home
€ | o

»

»

]

(]
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EE'; » @ WMS/WMTS
» B XYZ Tiles
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» ) OWS
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; A Y /
| @ Type to locate (Ctrl+k) | Coordinate| 20.51955-34.01389 |9 Scale 1:6588 ~| & magnifier| 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

4. Click on the other vertices and snap them into place.

The topologically correct border looks like this:

*example - QGIS
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Go ahead and join a few more areas using the Vertex Tool.

&
You can also use the £ Add Polygon Feature 40,5] ¢ fi]] the gap between the two forest polygons. If you have enabled
Avoid overlap, you don’t have to add every single vertex - they will be added automatically if your new polygon
overlaps the existing ones.

If you are using our example data, you should have a forest area looking something like this:

*example - QGIS B
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o @ pB2
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» @& wes
» &% WFS / OGC API - Features
» O ows
& ArcGisMapServer
\‘71"4' ArcGisFeatureServer
¢ GeoNode
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Q Type to locate (Ctrl+K) Coordinate| 20.48916-34.00526 |9 Scale| 1:14392 ~ | @ Magnifier| 100% = | Rotation |0,0° | |v/ Render # EPsG4326 @

Don’t worry if you have joined more, less or different areas of forest.

5.2.3 / Follow Along: Tool: Simplify Feature

Continuing on the same layer, we will test the %) Simplify Feature 46,]:

1. Click on it to activate it.
2. Click on one of the areas which you joined using either the Vertex Tool or Add Feature tool. You will see this
dialog:
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|J¢§ancel|l «/ OK ]

- |

Method | simplify by distance

Tolerance ’ oloooo00
1 feature(s): 17 to 17 vertices (100%)

:] Layer units

3. Modify the Tolerance and watch what happens:

|X§ancel|[ «/ OK ]

- |

Method | Simplify by distance

A
* | Tolerance ’

1 feature(s): 17 to 5 vertices (29%)

|:] | Layer units

This allows you to reduce the number of vertices.

4. Klicken Sie auf OK
145
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The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice that
the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it should.
So this tool is better suited for stand-alone features.

Before you go on, set the polygon back to its original state by undoing the last change.

5.24 / Try Yourself Tool: Add Ring

The AddRing t00] allows you to add an interior ring to a polygon feature (cut a hole in the polygon), as long as the
hole is completely contained within the polygon (touching the boundary is OK). For example, if you have digitized
the outer boundaries of South Africa and you need to add a hole for Lesotho, you would use this tool.

If you experiment with the tool, you may notice that the snapping options can prevent you from creating a ring inside
a polygon. So you are advised to turn off snapping before cutting a hole.

1. Disable snapping for the 1Landuse layer using the @ Enable Snapping by tton (or use the shortcut s).

2. Use the AddRing t40] to create a hole in the middle of a polygon geometry.

(g
3. Draw a polygon over the target feature, as if you were using the Add polygon (0],

4. When you right-click, the hole will be visible.

5. Remove the hole you just created using the £ Delete Ring 0]

Bemerkung: Click inside the hole to delete it.

Check your results

5.2.5 / Try Yourself Tool: Add Part

The E Add Part t60] allows you to add a new part to a feature, that is not directly connected to the main feature. For
example, if you have digitized the boundaries of mainland South Africa, but you haven’t yet added the Prince Edward
Islands, you would use this tool to create them.

1. Select the polygon to which you wish to add the part by using the -3 Select Features by area or single click (¢,0,]

2. Use the Add Part tool to add an outlying area.

3. Delete the part you just created using the €} £ Delete Part 6]

Bemerkung: Click inside the part to delete it.

Check your results
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5.2.6 / Follow Along: Tool: Reshape Features

The E‘}D Reshape Features 400] js used to extend a polygon feature or cut away a part of it (along the boundary).

Extending:

1. Select the pOlngl’l llSil'lg the % Select Features by area or single click tool.
2. Left-click inside the polygon to start drawing.
3. Draw a shape outside the polygon. The last vertex should be back inside the polygon.

4. Right-click to finish the shape:

0666 QGIS 2.0.1-Dufour - basic_map
SPLLHPAPLRAMLNRS & & B e BE =0 mno A B

= ) B

> @V rvers » 2 V] <
» school_property

/ landuse

) & 0420C_2010_327_RGB_LATLNG

EY YRR
o

>
X

Euargstiter

61 3

%

N
/

A

.

< Pt el Pt Reaeplton O iz

Qe S

[isee ETT

Validation finished. There is a new olugin available [95] Coordinate: 20.4945,34.0787 Scale (1519957 [+ (Y] & Render EPSG4326 (] |

This will give a result similar to:
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QGIS 2.0.1-Dufour - basic_map.

666

DBELR O LLOHPLLALR & & W GEBE =D 32 1 BW
PUMB R x LB B SFE R R
P BRVIRRARBORP L C

o0 Layers
S
Tl ™ buildings Aak
» & roads 4@“ x
0 ot 5
g
» g - rvers ff&

» (9 school_property
@ %

[ 5 3420C_2010_327_RGB_LATLNG

Qv x
@ =
%
Viv ‘.
0 BuiEpegsiier
Validation finished. There is a new plugin available Coordinate: [ 204430340604 | Scale [1:19951 [+ [$| @ Render EPSG:4326 (€3]

Cut away a part:

.
1. Select the pOlngIl llSiIlg the % Select Features by area or single click tool.

2. Click outside the polygon.

3. Draw a shape inside the polygon. The last vertex must be back outside the polygon.

4. Right-click outside the polygon:

QGIS 2.0.1-Dufour - basic_map
BOR S LLr8PLRALR & @R GEBE = 50 [T B®
RRAGLxBE SE" 2% DS
® 28
s

WRE22®LC

» (4 (- school_property

[ & 3420C_2010_327_RGB_LATLNG

Validation finished. The i Coordinate: 20.4733,-34.0967 Scale [1:19951 |+ [$] @ Render EPSG:4326 y
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The result of the above:

[eXeXe) QGIS 2.0.1-Dufour - basic_map.

DEBEBBLDR 0$P2LAAPLLALRS & 6 B8 BE &0 52 /0 B Y
PIUB BB /& h>x0 = T -S> - W]
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> & 0 water
® &/ routes “ g
4 - . y é Iy ]
) IRV NSO &
@ » ¥ ) school_property X Y, ¥
X v.
@) () i 392002010.327.RGB_LATLNG N Ll .
A X
’ Felion x
KA x X
@ W > 3
% 5% ol e
% o e/ SN X
“ 7 * X % Dontsots Neloned P Biineo €xlo .
Vi A S .
4 & N T ° Buisfjagerttsr
x < - N I
3 o . o \ ~
’ WK \
y o N, A
S y
< et Mo Pt Reepten O i
o R e
’ /Xv
| NW/// \A
rower
Validation finished. 20.4733,-34.0067 Scale [1:19951 +) [/] @ Render EPSG:4326 (@3] y

5.2.7 / Try Yourself Tool: Split Features

as . . i~
The g% SplitFeatures ¢o6] js similar to the Reshape Features 10] except that it does not delete either of the two parts.
Instead, it keeps them both.

We will use the tool to split a corner from a polygon.

1. First, select the 1anduse layer and re-enable snapping for it.

de_ .
2. Select the g% SPlitFeawres ¢60] and click on a vertex to begin drawing a line.

3. Draw the bounding line.

4. Click a vertex on the ,,opposite” side of the polygon you wish to split and right-click to complete the line:
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QIS 2.0.1-Dufour - basic_map.

PLRAMLSRS & e My e BE = 0 mo o BY

SIS

» & 5 school_property
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5. At this point, it may seem as if nothing has happened. But remember that the 1anduse layer is rendered
without border lines, so the new division line will not be shown.

;
6. Use the Eﬁ‘a Select Features by area or single click 0] to select the part you just split out; the new feature will now be

highlighted:

6606 QGIS 2.0.1-Dufour - basic_map
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X
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5.2.8 == Try Yourself Tool: Merge Features

Now we will re-join the feature you just split out to the remaining part of the polygon:

1. Experiment with the @Merge Selected Features and “T— Merge Attributes of Selected Features tools.
2. Note the differences.

Check your results

5.2.9 In Conclusion

Topology editing is a powerful tool that allows you to create and modify objects quickly and easily, while ensuring
that they remain topologically correct.

5.2.10 What’s Next?

Now you know how to digitize the shape of the objects easily, but adding attributes is still a bit of a headache! Next
we will show you how to use forms, making attribute editing simpler and more effective.

5.3 Lesson: Formulare

When you add new data via digitizing, you’re presented with a dialog that lets you fill in the attributes for that feature.
However, this dialog is not, by default, very nice to look at. This can cause a usability problem, especially if you
have large datasets to create, or if you want other people to help you digitize and they find the default forms to be
confusing.

Fortunately, QGIS lets you create your own custom dialogs for a layer. This lesson shows you how.

The goal for this lesson: To create a form for a layer.

5.3.1 \ Follow Along: Using QGIS‘ Form Design Functionality

1. Select the roads layer in the Layers panel

2. Enter Edit Mode as before

3. Open the roads layer’s attribute table

4. Right-click on any cell in the table. A short menu will appear, that includes the Open form entry.
5. Click on it to see the form that QGIS generates for this layer

Obviously it would be nice to be able to do this while looking at the map, rather than needing to search for a specific
street in the Attribute Table all the time.

1. Select the roads layer in the Layers panel

2. Using the QR Identify Features 0] click on any street in the map.

3. The Identify Results panel opens and shows a tree view of the fields values and other general information about
the clicked feature.

4. At the top of the panel, check the Auto open form for single feature results checkbox in the X sup:Identify
Settings menu.
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5. Now, click again on any street in the map. Along the previous Identify Results dialog, you’ll see the now-familiar

form:
0086 Attributes - roads
osmid 47587910 al
name INULL |
highway [unclassified |
waterway | NULL |
aerialway |NULL |
barrier INULL |
man_made |NULL |
other_tags "lanes'=>"2" al
((Cancel | [N

6. Each time you click on a single feature with the Identify tool, its form pops up as long as the Auto open form is
checked.

5.3.2 \ Try Yourself Using the Form to Edit Values

If you are in edit mode, you can use this form to edit a feature’s attributes.

1. Activate edit mode (if it isn’t already activated).

2. Using the eﬁs Identify Features 0], click on the main street running through Swellendam:
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Y 4 ® X *.
% XK S e : ¢ osmid  [2a8a08188

nams [Voortreic Sreet al

highway [tertiary al

waterway | NULL ‘

aerialway | NULL |

barrier [nuLe |

man_made |NULL |

other_tags |"Ianm"=>"2“

3. Edit its highway value to be secondary

4. Exit edit mode and save your edits

5. Open the Attribute Table and note that the value has been updated in the attributes table and therefore in the
source data

5.3.3 / Follow Along: Setting Form Field Types

It’s nice to edit things using a form, but you still have to enter everything by hand. Fortunately, forms have different
kinds of so-called widgets that allow you to edit data in various different ways.

1. Open the roads layer’s Properties...
2. Switch to the Fields tab. You'll see this:
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'ri Information

8 source

% symbology

€7 Labels

€O Masks

d Diagrams

N# 3D View

E g Fields

Attributes
Form

Joins

.’l Auxiliary
Storage

{;,I_GI Actions

[ @ve | syle -

Layer Properties - roads | Fields

(/] (8]

id -~ Name Alias Type Typename Length Precision Comment WMS WFS *
122 0 [fid glonglong Integer64 0 0 v v
abe 1 Full_id Qstring  String 255 0 v v
abc 2 osm_id Qstring  String 255 0 v v
abc 3 osm_type QString String 255 0 v v
N S P O N N
ac 5 lanes Qstring  String 0 v v
ac §  maxspeed Qstring  String 255 0 v v
abc 7 oneway QString  String 255 0 v v
abc 8 | ref QString String 255 0 v v
abc 9 | surface Qstring  String 255 0 v v
ac 10 | name Qstring  String 255 0 v v
abc 11 embankment Qstring  String 255 0 v v
abc 12 | maxweight Qstring String 255 0 v v -

| «/Apply || % cancel H &/ OK ]

3. Switch to the Attributes Form tab. You'll see this:

fi Information
':{S_\ Source
%" symbology
€3 Labels
€l Masks

. Diagrams

Wg 3D View

E Fields
Attributes Form

Joins

ﬂ Auxiliary
Storage

(;Q Actions

Layer Properties - roads | Attributes Form

| Autogenerate

~ | |E\ | show form on add feature (global settings) ~ |

*  Available Widgets k-

Flelds

osm_type

highway

lanes

maxspeed

oneway

ref

surface

name

embankment
maxweight
destination:back...
destination:Fforward
destination:ref:ba...
destination:symb...
cutting

access

hav

foot

.| @nelp || syle -]

JApply || ®cancel || JoOK |

4. Click on the oneway row and choose Checkbox as Widget Type in the list of options:
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Layer Properties - roads | Attributes Form %

Q Autogenerate ~ || ® || show form on add feature (global settings) ~
G’ Aval!able widgets v General
¥ Fields
A2 4 Fid .
™ fFull_id Al
¥ 4 osm_id Comment
osm_type .
- highway v| Editable Label on top
lanes »
o T —
- ref
| surface Classification
* name
Ny embankment Color
maxweight Date/Ti
E i destination:backw... ate/Time
destination:forward
J destinat!on:ref:ba... « Attachment
destination:symbo... i
cutting Hidden
access
v hgv
ﬂ foot
@ | sac_scale
© name:af .
- lanes:backward Relation Reference
lanes:forward Text Edit
Q" Leicgy_crleef Unique Values
cycleway ¥ Uuid Generator
sidewalk
“ service Value Map
! bridge Value Relation
layer = =
']

_| @Help Style -~ </ Apply || % cancel

5. Klicken Sie auf OK

6. Enter edit mode (if the roads layer is not already in edit mode)

7. Click on the &% Identify Features 6]
8. Click on the same main road you chose earlier

You will now see that the oneway attribute has a checkbox next to it denoting True (checked) or Fa 1 se (unchecked).

5.34 .ﬂ—. Try Yourself

Set a more appropriate form widget for the highway field.

Check your results

5.3.5 ﬂ—- Try Yourself Creating Test Data

You can also design your own custom form completely from scratch.
1. Create a simple point layer named test-data with two attributes:
¢ name (text)

* age (integer)
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New GeoPackage Layer x

Database training_data.gpkg

Table name test-data

v

Geometry type Point

Include Z dimension Include M values
EPSG:4326 - WGS 84 - ||
New Field
Name
Type 123 \Whole Number (integer) -
Maximum length
Fields List
Name Type Length
name text 80
age integer

w Advanced Options

Layer identifier test-data
Layer description

Feature id column | fid
Geometry column geometry

v| Create a spatial index

@ Help Ocancel @ok

2. Capture a few points on your new layer using the digitizing tools so that you have a little data to play with. You
should be presented with the default QGIS generated attribute capture form each time you capture a new point.

Bemerkung: You may need to disable Snapping if still enabled from earlier tasks.

test-data - Feature Attributes X

fid | Autogenerate v
name richard
age 23 =

@ cancel QoK
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5.3.6 === Follow Along: Creating a New Form

Now we want to create our own custom form for the attribute data capture phase. To do this, you need to have QT
Designer installed (only needed for the person who creates the forms).
1. Start QT Designer.

2. In the dialog that appears, create a new dialog:

0060 New Form

templates/forms
Dialog with Buttons Bottom
Dialog with Buttons Right
Dialog without Buttons
Main Window
Widget

Widgets

Cancel OK

Embedded Design

Device: Mone

Screen Size: [ Default size B

[ Show this Dialeg on Stariup

| Open.. | | Recentw | | Close | [ Create ]

3. Look for the Widget Box along the left of your screen (default). It contains an item called Line Edit.
4. Click and drag this item into your form. This creates a new Line Edit in the form.

5. With the new line edit element selected, you’ll see its properties along the side of your screen (on the right by
default):

5.3. Lesson: Formulare 157



QGIS Training Manual

10.
11.
12.

13.
14.

000

Property Editor

[Filter

lineEdit : QLineEdit

ar, = 7,

Praperty

Valug

lineEdit

-

enabled ™

» geometry [(80, 40), 113 x 21]

» sizePolicy [Expanding, Fixed, 0, 0]

»  minimumSize 0x0

» maximumSize 16777215 x 16777215

» sizelncrement 0x0

» baseSize 0x0
palette Inherited

» font A [Lucida Grande Ul, 13]
cursor | I1Beam
mouseTracking ™
focusPolicy StrongFocus
contextMenuPolicy | DefaultContextMenu
acceptDrops ™

» toolTip

b statusTip

» whatsThis

» accessibleName

» accessibleDescrip...
layoutDirection LeftToRight

autoFillBackground

styleSheet

» locale

English, SouthAfrica

p inputMethodHints ImhNone

\

» inputMask

b text
maxLength 32767
frame [21
echoMode Normal
cursorPosition 0

» alignment AlignLeft, AlignVCenter
dragEnabled ]
readOnly ]

p placeholderText

curanrifnvaShiles

| nniralMovaShile

Set its name to name.
Using the same approach, create a new Spin Box and set its name to age.

Add a Label with the text Add a New Person in a bold font (look in the object properties to find out how
to set this). Alternatively, you may want to set the title of the dialog itself (rather than adding a label).

Add a Label for your Line Edit and your Spin Box.
Arrange the elements to your own desire.
Click anywhere in your dialog.

Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays
out your dialog automatically.

Set the dialog’s maximum size (in its properties) to 200 (width) by 150 (height).

Your form should now look similar to this:
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8 -add_people.ui* |- [X

15. Save your new form as exercise_data/forms/add_people.ui

16. When it’s done saving, you can close Qf Designer

5.3.7 ﬂ'—- Follow Along: Associating the Form with Your Layer

Go back to QGIS
Double click the fest-data layer in the legend to access its properties.
Click on the Attributes Form tab in the Layer Properties dialog

In the Attribute editor layout dropdown, select Provide ui-file.

Al

Click the ellipsis button and choose the add_people . ui file you

just created:

Layer Properties - test-data | Attributes Form *

Q Provide ui-file -

“ Edit Ul |/home/qgis-user/forms/add_people.ui

G’ Information

Available widgets

® v General
W\ Source ~ Fields
fid .
ES Al
& symbology name ias
g Comment
€= Labels Relations i
~ Other widgets | Editable Label on top
@ Masks QML Widget
HTML Widget v Widget Type
Diagrams
Text Edit
Wg 3D View
Multiline
E Fields
Attributes Form
Joins w Constraints
L Auxiliary
&1 storage Not null
(;‘.-G) Actions Unique
: Expression
. Display
” Expression description
& Rendering
) Enforce expression constraint
Variables
_ v Defaults
a Metadata
Default value
E Dependencies Preview
Legend Apply default value on update
QGIS Server
@Help Style -~

6. Click OK on the Layer Properties dialog

7. Enter edit mode and capture a new point

# || Show Form on add fFeature (global settings) ~

# Cancel

« Apply
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8. When you do so, you will be presented with your custom dialog (instead of the generic one that QGIS usually
creates).

9. If you click on one of your points using the Q% Identify Features 46,6] you can now bring up the form by right
clicking in the identify results window and choosing View Feature Form from the context menu.

10. If you are in edit mode for this layer, that context menu will show Edit Feature Form instead, and you can then
adjust the attributes in the new form even after initial capture.

5.3.8 In Conclusion

Using forms, you can make life easier for yourself when editing or creating data. By editing widget types or creating
an entirely new form from scratch, you can control the experience of someone who digitizes new data for that layer,
thereby minimizing misunderstandings and unnecessary errors.

5.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, you may want to check out this blog entry
about creating custom feature forms with Python logic, which allows advanced functions including data validation,
autocompletion, etc.

5.3.10 What’s Next?

Opening a form on identifying a feature is one of the standard actions that QGIS can perform. However, you can also
direct it to perform custom actions that you define. This is the subject of the next lesson.

5.4 Lesson: Aktionen

Now that you have seen a default action in the previous lesson, it is time to define your own actions.

An action is something that happens when you click on a feature. It can add a lot of extra functionality to your map,
allowing you to retrieve additional information about an object, for example. Assigning actions can add a whole new
dimension to your map!

The goal for this lesson: To learn how to add custom actions.

In this lesson you will use the school_property layer you created previously. The sample data include photos of each
of the three properties you digitized. What we are going to do is to associate each property with its image. Then we
will create an action that will open the image for a property when clicking on the property.

5.4.1 \ Follow Along: Add a Field for Images

The school_property layer has no way to associate an image with a property yet. First we will create a field for
this purpose.

1. Open the Layer Properties dialog.
2. Click on the Fields tab.
3. Toggle editing mode:
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Layer Properties - school_property | Fields

NE

d - 1Toggle editing mode t'pe Type name  Length Precision = Comment

‘:{:\? Source

1230 |id glonglong | Integer64 10 0 v

%" symbology

abc | name Qstring  String 80 0 v
€3 Labels

B Masks

- .
. [MELEIN S

W7 3D View
E 5 Fields

E Aktributes Form

1 4

Joins
s Auxiliary . @telp || style -  Japply | ®cancel || Jok |

4. Add a new column:

Layer Properties - school_property | Fields

If? ® (/] |E
New field |me Alias Type Type name Length Precision Comment

1220 |id glonglong | Integer64 10 0 v

(;’i Information

:{:\\ Source . :
: abc name Qstring String 80 0 v

%~ symbology
€= Labels
B Masks

. Diagrams

Ng 3D View

E g Fields

E Attributes Form

5. Enter the values below:
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Add Field

Name

Comment

Type

|image|

Text (string)

Provider type string

Length

il
-

% cancel | o OK |

6. After the field has been created, move to the A#tributes Form tab and select the image field.

7. Set Widget Type to Attachment:

Layer Properties - school_property | Attributes Form x

G’ Information

‘:{:\} Source

¥ symbology

> .
" Diagrams

W# 3D View
ﬁ Fields

::E: Attributes For

Joins

L Auxiliary
&M Storage

«;@ Actions
- Display
Qj./ Rendering

Variables

l Metadata

ﬁ Dependencies
Legend

& qais server

8. Click OK in the Layer Properties dialog.

* | Available widgets

~ Other Widgets

v General

Alias
Comment
v| Editable

v Widget Type
Attachment

Path

Label on top

~ | @ || show form on add feature (global settings) ~

-

Default path |/home/tveite/Downloads/QGIS/QGISTrainin... || ... | €

Relative paths

Storage Mode

@ File paths
Directory paths

v Display Resource Path

v Display button to open File dialog

Filter

Use a hyperlink For document path (read-only)

-

</ Apply || % cancel oK

9. Use the Identify tool to click on one of the three features in the school_property layer.

Since you are still in edit mode, the dialog should be active and look like this:
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school_property - Feature Attributes .

Actions

id |2 |

name school campus

image

% cancel | &/ OK |

10. Click on the browse button (the ... next to the image field).

11. Select the path for your image. The images are in exercise_data/school_property_photos/ and
are named the same as the features they should be associated with.

12. Click OK.
13. Associate all of the images with the correct features using this method.

14. Save your edits and exit edit mode.

5.4.2 \ Follow Along: Creating an Action

1. Open the Actions tab for the school_property layer, and click on the IfI-I-II:I Addanewaction ypton,

Layer Properties - school_property | Actions x

Q ¥ Action List

Description Short Title Action  Capture Action Scopes On Notification Only when editable

€3 Labels
€D masks

a Diagrams

W# 3D View

ﬁ Fields

E Attributes Form

Joins
[ ¥

ﬂ Auxiliary Storage Lk Create Default Actions

Actions Add a new action

» Show in Attribute Table

2. In the Add New Action dialog, enter the words Show Image into the Description field:
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Add New Action -~

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 3
| E Insert
Execute if notification matches

Enable only when editable

@Hel ¥ cancel
p L

What to do next varies according to your operating system, so choose the appropriate course to follow:

¢ Windows
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Click on the Type dropdown and choose Open.
e Ubuntu Linux

Under Action, write eog for the Gnome Image Viewer, or write display to use ImageMagick.
Remember to put a space after the command!

* MacOS
1. Click on the Type dropdown and choose Mac.
2. Under Action, write open. Remember to put a space after the command!
Now you can continue writing the command.

You want to open the image, and QGIS knows where the image is. All it needs to do is to tell the Action where
the image is.

3. Select image from the list:
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Add New Action i3

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 eoq- [%imageS]

4 b
123 id

abc name

@Help % Cancel

4. Click the Insert field button. QGIS will add the phrase [$ "image" %] inthe Action Text field.
5. Click the OK button to close the Add New Action dialog

166 Kapitel 5. Module: Vektordaten erzeugen



QGIS Training Manual

6.

Click OK to close the Layer Properties dialog

Now it is time to test the new action:

1.

2.

Click on the school_property layer in the Layers panel so that it is highlighted.

: "@-\l‘- Run feature action : :
Find the ==z Runfeatureaction bytton (in the Attributes Toolbar).

Click on the down arrow to the right of this button. There is only one action defined for this layer so far, which
is the one you just created.

4.
5.

TN oo

Click the button itself to activate the tool.
Using this tool, click on any of the three school properties.

The image for that property should open.

543 / Follow Along: Searching the Internet

Let’s say we are looking at the map and want to know more about the area that a farm is in. Suppose you know nothing
of the area in question and want to find general information about it. Your first impulse, considering that you're using
a computer right now, would probably be to Google the name of the area. So let’s tell QGIS to do that automatically
for us!

1.

Open the attribute table for the landuse layer.

We will be using the name field for each of our landuse areas to search Google.
Close the attribute table.

Go back to Actions in Layer Properties.

Click on the Create Default Actions button to add a number of pre-defined actions.

Remove all the actions but the Open URL action with the short name Search Web using the =

Remove the selected action by 1tton below.

Double-click on the remaining action to edit it

Change the Description to Google Search, and remove the content of the Short Name field.

Make sure that Canvas is among the checked Action scopes.

What to do next varies according to your operating system, so choose the appropriate course to follow:
¢ Windows

Under Type, choose Open. This will tell Windows to open an Internet address in your default browser,
such as Internet Explorer.

¢ Ubuntu Linux

Under Action, write xdg—open. This will tell Ubuntu to open an Internet address in your default browser,
such as Chrome or Firefox.

¢ MacOS

Under Action, write open. This will tell MacOS to open an Internet address in your default browser, such
as Safari.
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Now you can continue writing the command

Whichever command you used above, you need to tell it which Internet address to open next. You want it to
visit Google, and to search for a phrase automatically.

Usually when you use Google, you enter your search phrase into the Google Search bar. But in this case, you
want your computer to do this for you. The way you tell Google to search for something (if you don’t want to
use its search bar directly) is by giving your Internet browser the address https://www.google.com/
search?gq=SEARCH_PHRASE, where SEARCH_PHRASE" is what you want to search for. Since we don’t
know what phrase to search for yet, we will just enter the first part (without the search phrase).

In the Action field, write https://www.google.com/search?g=. Remember to add a space after
your initial command before writing this in!

Now you want QGIS to tell the browser to tell Google to search for the value of name for any feature that you
could click on.

10. Select the name field.

11. Click Insert button:
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Edit Action -~

Type Generic - Capture output

Description |Google Search
Short Mame |Leave empty to use only icon

lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 xdg-open-http://www.google.com/search?q=[%name%]

1 b

| E Insert

Execute if notification matches || |

Enable only when editable

@Help % Cancel « OK

What this means is that QGIS is going to open the browser and send it to the address https://www.

google.com/search?g=[% "name" %].[% "name" %] tells QGIS to use the contents of the
name field as the phrase to search for.
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So if, for example, the landuse area you click on is named Marloth Nature Reserve, QGIS is going to
send the browser to https://www.google.com/search?g=Marloth%20Nature%20Reserve,
which will cause your browser to visit Google, which will in turn search for ,Marloth Nature Reserve®.

12. If you have not done so already, set everything up as explained above.
13. Click the OK button to close the Add New Action dialog
14. Click OK to close the Layer Properties dialog

Now to test the new action.

@ .
1. With the landuse layer active in the Layers panel, click on the down arrow to the right of the &1& Run feature action

button, and select the only action (Google Search) defined for this layer.

2. Click on any landuse area you can see on the map. Your browser will now open, and will start a Google search
for the place that is recorded as that area’s name value.

Bemerkung: If your action doesn’t work, check that everything was entered correctly; typos are common with this
kind of work!

5.4.4 === Follow Along: Open a Webpage Directly in QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcomings with this approach
in that it adds an unknowable dependency — will the end-user have the software required to execute the action on
their system? As you've seen, they don’t necessarily even have the same kind of base command for the same kind
of action, if you don’t know which OS they will be using. With some OS versions, the above commands to open the
browser might not work at all. This could be an insurmountable problem.

However, QGIS sits on top of the incredibly powerful and versatile Qt library. Also, QGIS actions can be arbitrary,
tokenized (i.e. using variable information based on the contents of a field attribute) Python commands!

Now you will see how to use a python action to show a web page. It is the same general idea as opening a site in an
external browser, but it requires no browser on the user’s system since it uses the Qt QWebView class (which is a
webkit based html widget) to display the content in a pop-up window.

Let us use Wikipedia this time. So the URL you request will look like this:
https://wikipedia.org/wiki/SEARCH_PHRASE
To create the layer action:
1. Open the Layer Properties dialog and head over to the Actions tab.
2. Set up a new action using the following properties for the action:
e Type: Python
* Description: Wikipedia

e Action Text (all on one line):

from ggis.PyQt.QtCore import QUrl; from ggis.PyQt.QtWebKitWidgets import._
—QWebView; myWV = QWebView (None); myWV.load (QUrl ('https://wikipedia.org/
—wiki/[$name%]"')); myWV.show ()
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Edit Action (]

Type Python - | | Capture output
Description Wikipedia
Short Name |Leave empty to use only icon
Icon
Action Scopes

Field Scope

Layer Scope

v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.

The content depends on the type.

For the type Python the content should be python code

For other types it should be a file or application with optional parameters

1 from-qgis.PyQt.QtCore import QUrl; from-qgis.PyQt.QtWebKitWidgets -inport-QWebViels; - myWV.=-QWebView(None); myWV.load(QUFL( hitps://wikipedia.org/wiki/[%namesl 1) ; myWV.show()

L] v

~|& Insert

Execute if notification matches || |

Enable only when editable

@Help % cancel /oK

There are a couple of things going on here:

 All the python code is in a single line with semi-colons separating commands (instead of newlines, the
usual way of separating Python commands).

* [$name%] will be replaced by the actual attribute value when the action is invoked (as before).

* The code simply creates a new QWebView instance, sets its URL, and then calls show () on it to make
it visible as a window on the user’s desktop.

Note that this is a somewhat contrived example. Python works with semantically significant indentation, so
separating things with semicolons isn’t the best way to write it. So, in the real world, you’d be more likely to
import your logic from a Python module and then call a function with a field attribute as parameter.

You could also use this approach to display an image without requiring that the users have a particular image
viewer on their system.

3. Try to use the methods described above to load a Wikipedia page using the Wikipedia action you just created.

5.4.5 In Conclusion

Actions allow you to give your map extra functionality, useful to the end-user who views the same map in QGIS. Due
to the fact that you can use shell commands for any operating system, as well as Python, the sky is the limit in terms
of the functions you could incorporate!

5.4.6 What’s Next?

Now that you’ve done all kinds of vector data creation, you will learn how to analyze the data to solve problems. That
is the topic of the next module.
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Module: Vektoranalyse

Nun, da Sie einige Funktionen bearbeitet haben, sollten Sie wissen, was man sonst mit ihnen machen kann. Kenndaten
mit Attributen zu besitzen, ist nett, aber am Ende sagt das nichts anderes aus als eine normale Nicht-GIS-Karte.

Der Hauptvorteil eines GIS ist: * Ein GIS kann Fragen beantworten. *

Fiir die ndchsten drei Module werden wir uns bemiihen, eine * Forschungsfrage * mit der Hilfe von GIS-Funktionen
zu beantworten. Zum Beispiel sind Sie ein Makler und Sie sind auf der Suche nach einer Wohnimmobilie in |
majorUrbanName | Fiir Kunden mit folgenden Kriterien:

1. Sie muss sich in Swellendam befinden.

2. Sie muss innerhalb einer verniinftigen Fahrstrecke einer Schule (ca. 1km) liegen.
3. Sie muss groBer als 100m? sein.

4. Nabher als 50m an einer Hauptstraf3e.

5. Niher als 500m an einem Restaurant.

Innerhalb der nichsten Module werden wir die Leistung von GIS-Analyse-Tools nutzen, um geeignete
Flacheneigenschaften fiir diese neue Wohnsiedlung zu lokalisieren.

6.1 Lesson: Reprojecting and Transforming Data

Let us talk about Coordinate Reference Systems (CRSs) again. We have touched on this briefly before, but haven’t
discussed what it means practically.

The goal for this lesson: To reproject and transform vector datasets.
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6.1.1 \ Follow Along: Projections

The CRS that all the data, as well as the map itself are in right now is called WGS84. This is a very common Geographic
Coordinate System (GCS) for representing data. But there’s a problem, as we will see.

1. Save your current map

2. Then open the map of the world which you will find under exercise_data/world/world.qgs
3. Zoom in to South Africa by using the Zoom In tool
4

. Try setting a scale in the Scale field, which is in the Statusbar along the bottom of the screen. While over South
Africa, set this valueto 1: 5 000 000 (one to five million).

5. Pan around the map while keeping an eye on the Scale field

Notice the scale changing? That’s because you are moving away from the one point that you zoomed into at 1:5
000 000, which was at the center of your screen. All around that point, the scale is different.

To understand why, think about a globe of the Earth. It has lines running along it from North to South. These longitude
lines are far apart at the equator, but they meet at the poles.

In a GCS, you are working on this sphere, but your screen is flat. When you try to represent the sphere on a flat
surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out. What
this means on a map is that the longitude lines stay equally far apart from each other, even at the poles (where they
are supposed to meet). This means that, as you travel away from the equator on your map, the scale of the objects
that you see gets larger and larger. What this means for us, practically, is that there is no constant scale on our map!

To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS ,,projects” or converts the data in a way
that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should reproject
our data to use a PCS.

6.1.2 \ Follow Along: ,,On the Fly“ Reprojection

By default, QGIS reprojects data ,,on the fly“. What this means is that even if the data itself is in another CRS, QGIS
can project it as if it were in a CRS of your choice.

You can change the CRS of the project by clicking on the & Current projection hytton in the bottom right corner of
QGIS.

1. In the dialog that appears, type the word global into the Filter field. A few CRSs should appear in the
Predefined Reference Systems field below.

2. Select WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 entry by clicking on it, and then click OK.

Notice how the shape of South Africa changes. All projections work by changing the apparent shapes of objects
on Earth.

3. Zoomtoascaleof 1:5 000 000 again, as before.
4. Pan around the map.
Notice how the scale stays the same!
,On the fly* reprojection is also used for combining datasets that are in different CRSs.

1. Add another vector layer to your map which has the data for South Africa only. You will find it as
exercise_data/world/RSA. shp.

2. Load it. A quick way to see its CRS is by hovering the mouse over the layer in the legend. It is EPSG:3410.
What do you notice?

The layer is visible even if it has a different CRS from the continents one.
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6.1.3 / Follow Along: Saving a Dataset to Another CRS

Sometimes you need to export an existing dataset with another CRS. As we will see in the next lesson, if you need
to make distance calculations on layer, it is always better to have the layer in a projected coordinate system.

Be aware that the ,on the fly* reprojection is related to the project and not to single layers. This means that a layer
can have a different CRS from the project even if you see it in the correct position.

You can easily export the layer with another CRS.

1.
2.
3.

Add the buildings dataset from training_data.gpkg
Right-click on the buildings layer in the Layers panel

Select Export » Save Features As... in the menu that appears. You will be shown the Save Vector Layer as...
dialog.

Click on the Browse button next to the File name field

Navigate to exercise_data/ and specify the name of the new layer as buildings_reprojected.
shp.

Change the value of the CRS. Only the recent CRSs used will be shown in the drop-down menu. Click on the
25 seectprjection button next to the drop-down menu.

The Coordinate Reference System Selector dialog will appear. In its Filter field, search for 34S.

Select WGS 84 / UTM zone 34S | EPSG:32734 from the list
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Coordinate Reference System Selector

Select the coordinate reference system for the vector file. The data points will be transformed fraom the layer
coordinate reference system.

Filter | ©. 345 a |
Recently used coordinate reference systems

Coordinate Reference System Authority 1D

WGS 84/ UTM zone 345 EPSG:32734

1

[»

Coordinate reference systems of the world Hide deprecated CRSs

wordinate Reference System Authority ID [
RGRDC 2005 / UTM zone 345 EPSG:4062
WGS 72 [ UTM zone 345 EP5G:32334
WGS 72BE / UTM zone 345 EP5G:32534

WG5S 84 / UTM zone 345 EP5G:32734

A

7

Selected CRS |WGS 84 / UTM zone 345

O iy Y —
Extent: 18.00, -20.00, 24.00, 0.00 o
Projd: +proj=utm +zone=34 +south .’I ) - .
+datum=WGS84 +units=m +no_defs - g

| [@|Help | | @ cCancel | [ & ok ]

9. Leave the other options unchanged. The Save Vector Layer as... dialog now looks like this:
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Save Vector Layer as...

Format ESRI Shapefile

File name |ome/matteo/exercise_data/exercise_data/buildings_reprojected.shp &

Layer name
CRS EPSG:32734 - WGS 84 7 UTM zone 345 - | |
Encoding UTF-8 -

v | Add saved file to map

b Select fields to export and their export options
v Geometry

Geometry type Automatic =

» Extent (current: layer)
P Layer Options

P Custom Options

Help @ Cancel oK

10. Klicken Sie auf OK

You can now compare the old and new projections of the layer and see that they are in two different CRS but they
are still overlapping.
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6.1.4 === Follow Along: Creating Your Own Projection
There are many more projections than just those included in QGIS by default. You can also create your own
projections.

1. Start a new map

2. Load the world/oceans. shp dataset

3. Go to Settings » Custom Projections... and you will see this dialog.

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters dh
=
Name
Format WKT (Recommended) -
Validate
Parameters
v Test

Use the text boxes below to test the CRS definition you are creating. Enter a coordinate where both the lat/long and the transformed result are known (for example by
reading off a map). Then press the calculate button to see if the CRS definition you are creating is accurate.

Geographic / WGS84 Destination CRS

Calculate

@Help Ocancel QoK

4. Click on the 'fl-:lll-:I Addnew CRS hytton to create a new projection
5. An interesting projection to use is called Van der Grinten I.Enter its name in the Name field.

This projection represents the Earth on a circular field instead of a rectangular one, as most other projections
do.

6. In Format, select WKT (Recommended)

7. Add the following string in the Parameters field:

PROJCRS ["unknown",
BASEGEOGCRS [ "unknown",
DATUM [ "unknown",
ELLIPSOID["unknown", 6371000,0,
LENGTHUNIT ["metre", 1,
ID["EPSG", 90011111,
PRIMEM["Greenwich", O,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8901]111],
CONVERSION["unknown",
METHOD ["Van Der Grinten"],

(Fortsetzung auf der néchsten Seite)
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(Fortsetzung der vorherigen Seite)

PARAMETER["Longitude of natural origin", 0,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",88021],

PARAMETER["False easting", 0,
LENGTHUNIT["metre", 1],
ID["EPSG",8806]1],

PARAMETER["False northing", O,
LENGTHUNIT["metre", 1],
ID["EPSG",8807111,

CS[Cartesian, 2],

AXIS[" (E)",east,

ORDER[1],
LENGTHUNIT["metre", 1,
ID["EPSG",9001111,

AXIS[" (N)",north,
ORDER[2],

LENGTHUNIT ["metre", 1,
ID["EPSG",9001111]

Custom Coordinate Reference System Definition X

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string fermat for specifying a CRS.

Name Parameters o
Van der Grinten | PROJCRS["unknown",BASEGEOGCRS["unknown", DATUM["unknown",ELLIPSOID["unknown",6371000,0,LENGTHUNIT["metre",1,ID[...
=
Name Van der Grinken |
Format WKT (Recommended) v
PROJCRS["unknown", =@ || validate

BASEGEOGCRS["unknown",
DATUM["unknown",
ELLIPSOID["unknown",6371000,0,
LENGTHUMIT["metre",1,
Parameters ID["EPSG",9001]]]],
PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],
CONVERSION["unknown",
METHOD["Van Der Grinten"], >

b Test

@Help Qcancel Qok

8. Klicken Sie auf OK

9. Click on the 2 Curent CRS bytton at the right of the status bar to change the project CRS
10. Choose your newly defined projection (search for its name in the Filter field)

11. On applying this projection, the map will be reprojected thus:
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n *Untitled Project - QGIS 9e45223d42 [tm] = o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Layers
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L]
Browser ‘ Layers |
| @ Type to locate (ctr+k) 1 legend entries removed Coortinate | 2652139.4502093) | scale | 1218427020 ‘-I & Magnifier | 100% 2] Rotation [0.0° [3][v] Render @ userao0o2s @

6.1.5 In Conclusion

Different projections are useful for different purposes. By choosing the correct projection, you can ensure that the
features on your map are being represented accurately.

6.1.6 Further Reading

Materials for the Advanced section of this lesson were taken from this article.

Read further information on Coordinate Reference Systems.

6.1.7 What’s Next?

In the next lesson you will learn how to analyze vector data using QGIS* various vector analysis tools.

6.2 Lesson: Vector Analysis

Vector data can also be analyzed to reveal how different features interact with each other in space. There are many
different analysis-related functions, so we won’t go through them all. Rather, we will pose a question and try to solve
it using the tools that QGIS provides.

The goal for this lesson: To ask a question and solve it using analysis tools.
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6.2.1 \ The GIS Process

Before we start, it would be useful to give a brief overview of a process that can be used to solve a problem. The way
to go about it is:

1. State the Problem
2. Get the Data
3. Analyze the Problem

4. Present the Results

6.2.2 \ The Problem

Let’s start off the process by deciding on a problem to solve. For example, you are an estate agent and you are looking
for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam

2. It must be within reasonable driving distance of a school (say 1km)
3. It must be more than 100m squared in size

4. Closer than 50m to a main road

5. Closer than 500m to a restaurant

6.2.3 \ The Data

To answer these questions, we are going to need the following data:
1. The residential properties (buildings) in the area
2. The roads in and around the town
3. The location of schools and restaurants
4. The size of buildings

These data are available through OSM, and you should find that the dataset you have been using throughout this
manual also can be used for this lesson.

If you want to download data from another area, jump to the Introduction Chapter to read how to do it.

Bemerkung: Although OSM downloads have consistent data fields, the coverage and detail does vary. If you find
that your chosen region does not contain information on restaurants, for example, you may need to chose a different
region.
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6.2.4 \ Follow Along: Start a Project and get the Data

We first need to load the data to work with.

1. Start a new QGIS project

2. If you want, you can add a background map. Open the Browser and load the OSM background map from the

XYZ Tiles menu.

*Untitled Project - QGIS [

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRRY OPLLHI PRRA.BENR

=g Q »
Dm_‘ %} Z m- TR = @
Layers @
e o [ ® T |7 9= gy <
~ [v| ¥ OpenStreetMap
Vo |
= \ C
&2
%
.\"a
% Swellend 5 ""'%
wellendam
M Browser (&]Es) . N
Q. LETHTO s ™ P L
L @ Postals E =
@' P MssQL S

% & pB2
b B WMS/WMTS
&~ |~ @ XYZTiles
\/:: Ty @ wes
» 47 WFS / OGC API - Features
K& |» @ ows
& ArcGisMapServer
4&» ArcGisFeatureServer
¢ GeoNode

[l v
Q Type to locate (Ctri+K)

3. Inthe training_data.

chapter:
1. buildings
2. roads
3. restaurants

4. schools

i

1| 2271701,-4029807 |9 & 1:53229 | & r|100% | a|00° +| ¥/ Render & Epsi3ssT @

gpkg Geopackage database, you will find most the datasets we will use in this

Load them, and also 1anduse.sqglite.

4. Zoom to the layer extent to see Swellendam, South Africa

Before proceeding we will filter the roads layer, in order to have only some specific road types to work with.

Some roads in OSM datasets are listed as unclassified, tracks, path and footway. We want to
exclude these from our dataset and focus on the other road types, more suitable for this exercise.

Moreover, OSM data might not be updated everywhere, and we will also exclude NULL values.

5. Right click on the roads layer and choose Filter....

6. In the dialog that pops up we filter these features with the following expression:
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"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS.
—NOT NULL

The concatenation of the two operators NOT and IN excludes all the features that have these attribute values
in the highway field.

IS NOT NULL combined with the AND operator excludes roads with no value in the highway field.

Note the ? icon next to the roads layer. It helps you remember that this layer has a filter activated, so some
features may not be available in the project.

The map with all the data should look like the following one:

tm_ch72 - QGIS B
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6.2.5 \ Try Yourself Convert Layers‘ CRS

Because we are going to be measuring distances within our layers, we need to change the layers‘ CRS. To do this, we
need to select each layer in turn, save the layer to a new one with our new projection, then import that new layer into

our map.

You have many different options, e.g. you can export each layer as an ESRI Shapefile format dataset, you can append
the layers to an existing GeoPackage file, or you can create another GeoPackage file and fill it with the new reprojected
layers. We will show the last option, so the training_data . gpkg will remain clean. Feel free to choose the best
workflow for yourself.

Bemerkung: In this example, we are using the WGS 84 / UTM zone 345 CRS, but you should use a UTM CRS
which is more appropriate for your region.

1. Right click the roads layer in the Layers panel
2. Click Export —> Save Features As...
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. In the Save Vector Layer As dialog choose GeoPackage as Format

. Click on ... for the File name, and name the new GeoPackage vector_analysis

. Change the CRS to WGS 84 / UTM zone 34S

3
4
5. Change the Layer name to roads_34S
6
7. Click on OK:

Save Vector Layer as... o

Format GeoPackage -

File name ning-Data-release_3.10/exercise_data/vector analysis.gpkg

Layer name roads 34S

CRS EPSG:32734 - WGS 84 / UTM zone 345 - | | &

Encoding

[#| Select fields to export and their export options
v Geomekry

Geometry type Automatic -

[ Extent (current: layer)
P Layer Options

P Custom Options

@Help ¥ Add saved file to map | ¥ Cancel

L
)
o]
-~

This will create the new GeoPackage database and add the roads_ 345 layer.

8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file
with _34S appended to the original name and removing each of the old layers from the project.

Bemerkung: When you choose to save a layer to an existing GeoPackage, QGIS will append that layer to the
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GeoPackage.

9. Once you have completed the process for all the layers, right click on any layer and click Zoom fo layer extent
to focus the map to the area of interest.

Now that we have converted OSM data to a UTM projection, we can begin our calculations.

6.2.6 \ Follow Along: Analyzing the Problem: Distances From Schools
and Roads

QGIS allows you to calculate distances between any vector object.

1. Make sure that only the roads_34S and buildings_34S layers are visible (to simplify the map while
you’re working)

2. Click on the Processing » Toolbox to open the analytical core of QGIS. Basically, all algorithms (for vector
and raster analysis) are available in this toolbox.

3. We start by calculating the area around the roads_34S by using the Buffer algorithm. You can find it in the
Vector Geometry group.
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Processing Toolbox

"ne0 A

Q

1 b . . . . A

() Recently used
(2 Cartography

(2} Database

() File tools

(2 Graphics

(2} Interpolation

(2} Layer tools

()} Network analysis
()} Raster analysis
() Raster terrain analysis
() Raster tools

() Vector analysis
(2} Vector creation
() Vector general
() Vector geometry

me Add geometry attributes
4% Aggregate

4% Boundary

4% Bounding boxes

= Centroids

+ Check validity

&% Collect geometries

# Concave hull (alpha shapes)

¥ Concave hull (k-nearest neighbaor)

4% Convert geometry type
& convex hull

4% Create layer from extent
4% Create wedge buffers

@ Delaunay triangulation
¥ Delete holes

4% Densify by count

4% Densify by interval

P Dissolve

4% Drape (set z-value from raster)
4# Drop M/Z values

¥ Eliminate selected polygons
4% Explode lines

4 Extend lines

¥ Extract specific vertices
"'* Extract vertices

4% Filter vertices by m value
4% Filter vertices by z value
4F Fix geometries

4% Geometry by expression
4 Interpolate point on line

i vrnn M hisensck ek

-

You can add more algorithms to the toolbox,
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Or you can type buf fer in the search menu in the upper part of the toolbox:

Strumenti di Processing &
w e O %)
| 2 buffer| & |

allc.

* (.} Geometria vettore
Buffer multi-anello (distanza costante)
Buffer su singalo lato
Create wedge buffers
Tapered buffers
Variable width buffer (by m-value)
v o GDAL
+ Geoprocessing di Vettori
- Buffer su singolo lato
aw Vettori buffer
- g GRASS
~ Raster (r.*)
@ r.buffer
& r.bufferlowmem
* Vettore (v.*)
@ v.buffer
-~ & SAGA
* Raster tools
& Raster buffer
& Raster proximity buffer
& Threshold raster buffer

= Wlmrtor aeneres |

4. Double click on it to open the algorithm dialog

5. Select roads_34S as Input layer, set Distance to 50 and use the default values for the rest of the parameters.
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»
Parameters | Log Buffer
Input layer . .
P y This algorithm computes a buffer area for all the
W/ roads_34S [EPSG:32734] v ||...|| @ features in an input layer, using a fixed or dynamic
distance.
Dist. The segments parameter controls the number of
Istance line segments to use to approximate a quarter circle
50,000000 @ % |meters K =N when creating rounded offsets.
Segments The end cap style parameter controls how line
s — endings are handled in the buffer.
d l The join style parameter specifies whether round,
el s miter or beveled joins should be used when
Round - offsetting corners in a line.
Join style The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
Round M distance from the offset curve to use when creating
Miter limit a mitered join.
2,000000 -

Dissolve result
Buffered

[Create temporary layer]

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

6. The default Distance is in meters because our input dataset is in a Projected Coordinate System that uses meter
as its basic measurement unit. You can use the combo box to choose other projected units like kilometers,
yards, etc.

Bemerkung: If you are trying to make a buffer on a layer with a Geographical Coordinate System, Processing
will warn you and suggest to reproject the layer to a metric Coordinate System.

7. By default, Processing creates temporary layers and adds them to the Layers panel. You can also append the
result to the GeoPackage database by:

1. Clicking on the ... button and choose Save fo GeoPackage...
2. Naming the new layer roads_buffer_50m

3. Saving it in the vector_analysis.gpkg file
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Input layer

Parameters ‘ Log

/" roads_34s [EPSG:32734]

-|[..][2]

Distance

| 50,000000

MR =2

@ 3| |meters

Segments

'5

rF
-

End cap style

'Round

Join style

'Round

Miter limit

2,000000

Fe
-

Buffered

Dissolve result

okg' table="roads_buffer_50m" (geom) |:|

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

0%

| @Help || RunasBatch Process... |

8. Click on Run, and then close the Buffer dialog

Now your map will look something like this:

| %Close |l «/Run ]
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If your new layer is at the top of the Layers list, it will probably obscure much of your map, but this gives you all the
areas in your region which are within 50m of a road.

Notice that there are distinct areas within your buffer, which correspond to each individual road. To get rid of this
problem:

1. Uncheck the roads_buffer_50m layer and re-create the buffer with Dissolve results enabled.
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Parameters ‘ Log

Input layer
"/ roads_34S [EPSG:32734] <~ | .| @]

Distance

150,000000 @ || |meters ~| €&

Segments

E <]
End cap style

'Round -
Join style

'Round -
Miter limit

2,000000 2]

issolve result

By Dissolve result

ok{python identifier: ‘DISSOLVE lgeom) | ... |

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

| 0%

| @Help || RunasBatch Process... |

2. Save the output as roads_buffer_50m_dissolved

3. Click Run and close the Buffer dialog

| %Close |l «/Run ]

Once you have added the layer to the Layers panel, it will look like this:
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Now there are no unnecessary subdivisions.

Bemerkung: The Short Help on the right side of the dialog explains how the algorithm works. If you need more
information, just click on the Help button in the bottom part to open a more detailed guide of the algorithm.

6.2.7 \ Try Yourself Distance from schools

Use the same approach as above and create a buffer for your schools.

It shall to be 1 km in radius. Save the new layer in the vector_analysis.gpkg file as
schools_buffer_ lkm_dissolved.

Check your results

6.2.8 \ Follow Along: Overlapping Areas

Now we have identified areas where the road is less than 50 meters away and areas where there is a school within 1
km (direct line, not by road). But obviously, we only want the areas where both of these criteria are satisfied. To do
that, we will need to use the Intersect tool. You can find it in Vector Overlay group in the Processing Toolbox.

1. Use the two buffer layers as Input layer and Overlay layer, choose vector_analysis.gpkg GeoPackage
in Intersection with Layer name road_school_buffers_intersect. Leave the rest as suggested
(default).
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Intersection B

3 .
Parameters = Log Intersection
Input layer

This algorithm extracts the

-~ schools_buffer 1km [EPSG:32734] ||...|| @ overlapping portions of features
in the Input and Overlay layers.
Features in the output

Overlay layer Intersection layer are assigned
the attributes of the overlapping
~'roads_buffer_50m [EPSG:32734] = || .- [|®]| |Features from both the Input and

Overlay layers.

Input fields to keep (leave empty to keep all fields) [optional]
Overlay fields to keep (leave empty to keep all fields) [optional]

v Advanced parameters

Overlay fields prefix [optional]

Intersection

lysis.gpkg' table="road_school buffers_intersect" (geom)

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

o Pl e M e ma

2. Klicken Sie auf Starten.

In the image below, the blue areas are where both of the distance criteria are satisfied.
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3. You may remove the two buffer layers and only keep the one that shows where they overlap, since that’s what
we really wanted to know in the first place:
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